, part Chapter @ C
)
® Practical Part 2- Windows 10

Chapter 8
Iindows 10

Introduction to Computer Skills 203 -



Introduction to
.............................................. Computer Skills

8- 1 What is the Operating System:

The Operating System (OS) is a set of computer programs that are responsible
for running the computer and managining its various hardware and software

components. The Operating System must be installed on the machine to be able
to use it as the OS represents the connection between the user and the computer.

8- 2 The Main Tasks of the Operating System:

Skill 8 -1
Recognize the tasks of the OS

The operating system has various tasks and functions, among these
functions:

e Starting the computer.

e Controlling all the hardware components from input, output, and storing units,
etc.

e Transferring data among the different components of the computer and saving
them on the storing units.

e Providing a user interface.

e Distributing the different roles on the computer users.

e Detecting and fixing the different system errors or faults.

e Securing the system and maintaining the secarcy.

e Manging the tasks and giving priority to implementing tasks.

e |oading the running applications and programs to the RAM.

8 -3 Types of Operating Systems:

Skill 8 - 2
Recognize the different types of OS

There are different types of operating systems:

¢ Single-Task OS: these operating systems allow the user to run one program at

a time. An example of these operating systems is the Disk Operating System
(DOS).

® Multi-Tasking OS: these operating systems allow the user to run more than
one program at a time. An example of these operating systems is Windows 10.
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e Multiprocessing OS: these operating systems are used for computers
containing more than one processor and are characterized by their ability to
distribute the tasks and processes on more than one processor to increase the
efficiency of the computer to increase the processing speed. An example of
these operating systems is the SUN-OS.

¢ Time Sharing OS: these operating systems are used for systems having more
than one user each of which is connected to peripheral units (input and output)
on the same computer. Each user is given a time interval to run his commands.
An example of these operating systems is the Unix.

e Real-Time OS: these operating systems are used in systems requiring input
and output at the same time for example in medical appliances, scientific
laboratories, spacecrafts. An example of these operating systems is the RT
Linux.

e Networks OS:these operating systems cotain components that allow the
computer to connect and serve another computer inside a particular network.
An example of these operating systems is Windows Server 2008.

8 -4 Introduction to Windows 10:

Microsoft is consideredas one of the leading software companies thanks to its
production to various important software programs. Among its famous software
programs and systems is Windows 10. Windows 10 is considered as the latest
version of its operating systems. |t appeared since September 30, 2014 and its
first edition was released in July 29, 2015. Windows 10 appeared immediately
after Windows 8.1 and Windows 9 was not released as expected. This is because
the company wanted to refer to the great advancement, updates, and various
advantages that Windows 10 has over Windows 8.1.

8 -4 -1 New Features of Windows 10

Skill8 - 3
Knowing New Features of Windows 10

(il

1. One OS for all machines: the most important advantage of Windows 10 is that
it runs suitably on all personal computers, laptops, smartphones, and tablets.

2. Reappearance of the Start Menu: one of the most annoying features of
Windows 8.1 is the disappearance of the Start Menu. In Windows 10, the Start
Menu reappeared but it has been merged with the Metro interface to provide
an attractive appearance.
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3. Multiples Desktops Property: now in Windows 10, you can create more than
one Desktop and move among these Desktops easily.

4. Desktop Applications: Apps are small programs from the world, smartphones,
and tablets such as weather, calculator, ...etc. In Windows 10, you can run the
apps separately as in Windows 8.1 or through the Desktop which is the new
feature in Windows 10. In addition, the number of apps has increased to more
than 2,000,000 apps existing onMicrosoft Store of Windows 10.

5. The WindowsAssistant “Cortana”: In Windows 10, Microsoft provided a digital
assistant and named it “Cortana”. Cortana is a program that allows the user to
reach the information, and files through audio and written commands.

6. The Loading Speed: Loading Windows 10 and start running it takes only 20
seconds approximately.

7. Microsoft Store: Microsoft Store that comes in Windows 10 contains many
applications such as social media applications,e.g.facebook, which allows
you to login to these applications without the need to browsingthem on the
internet.

8. Running Applications: Windows 10 runs most of the applications that run on
Windows Vista, Windows 7, Windows 8, and Windows 8.1.

9. Protection and Security: In Windows 10, you can sign into your computer
through various methods such as password, facial recognition, fingerprint,
eyeprint when the hardware required is available on your machine.

8- 4- 2 Window 10 System Requirements

Skill 8 -4
System requirements to upgrade to Windows 10

il

You can upgrade to Windows 10 if the operating system on your machine is
a legal copy of Windows 7 or Windows 8.1. Also, there are other software and
hardware requirements to be able to run Windows 10:

1. Atleast 1 GHz processor.

2. Atleast 1 GB RAM to run Windows 10 32 bit and 2 GB RAM to run Windows
10 64 bit.

3. Afree storage space not less than 16 GB for 32 bit and 20 GB for 64 bit.

4. DirectX 9 or the latest version of WDDM 1.0.
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8 -4- 3 Editions of Windows 10:

Skill 8- 5
Knowing the different editions of Windows 10 and
the features of each

Microsoft has released different editions of Windows 10 (32 bits and 64 bits).
Each edition contains certain features to cover the need of particular users and
these editions are:

1. Home Edition: this edition targets the ordinary users. It contains the Start
Menu and its applications. We need a desktop with complete specifications
to run the classic Windows programes.

2. PRO Edition: this edition targets small corporations. It contains all the
features of the Home Edition in addition to some extra features for networks

and encrypting data.

3. Mobile Edition: this edition has been designed for smart phones and tablets
and provide different advantages among which maintaining the battery for

longer periods.

4. Entreprise-Entriprise/Mobile Edition: this edition was designed for large
corporations that has many branches in different cities and that uses
computers of different types and specifications from desktops, laptops,
and smart phones.

5. Education Edition: Microsoft allocated thus edition for educational
institutions such as school, institutes and universities.

6. Internet of Things (IOT) Edition: this copy of Windows 10 is more specialized
where it is used to run things through the internet such as controlling and
running ATMs and controlling home appliances through the internet.

8- 5 Desktop:

Skill 8 - 6
Recognizing Desktop

Desktop is the main screen that appears on starting Windows 10. It contains a
set oficonsthat tell about the applications and programs installed on the computer.
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You can add shortcuts for the programs and applications on the Desktop to ease
reaching them see Fig. 8- 1.

Here it Shows the Desktop Icons
and Shortcuts of the Applications
Installed in This PC

Desktop Icons

EEET EE ~oaum 2

8- 5- 1 Start Menu:

Skill 8 - 7
running programs and applications from the Start Menu

—
Ad

The Start Menu is the main menu that appears in the left bottom of the

Desktop. It allows you to control the applications, programs, files, settings, icons,
search, etc. Windows 10 has returned the Start Menu with a modern view as in
Fig. 8 -2.
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StartMenu = @ -~ @& « 0 ¢

Changing the Start Menu:

Skill8 -8
Changing the Start Menu

i

To change the Start Menu, follow the following steps:

1. Right click on an empty place on the Desktop. The Desktop options menu
will pop up. Select “Personalization” as in Fig. 8 -3.

View
Sort by
Refresh

Paste
Paste shortcut

Undo Delete

83 Graphics Properties...
8 Graphics Options

88 O Type here to search
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2. The “Settings” window will appear. Click on “Start”. Then, make the required
changes to the Start Menu as in Fig. 84-.

Settings
@ Home Start
Find a setting I Show more tiles on Start
@ on
Personalization
Show app list in Start menu
On
Bd  Background &=
Show recently added apps
® Colors @ o
R Lockscreen Show most used apps
@ o
@ Show suggestions occasionally in Start
Ay Fonts Q On
Use Start full screen
= S @ of
= Taskbar A Show recently opened items in Jump Lists on Start or the taskbar and in
l_ File Explorer Quick Access
Figure 8-4: On
Modifying 1 S . _m 'y
the Start tart Options I
Menu 2 Gontrol Options of the Start Menu SettingD

82-5- Dealing with the Desktop Icons:
¢ Knowing the most important Desktop icons

Skill 8 -9
Knowing the most important Desktop icons

Icons represent a shortcut to quickly start the applications and programs
installed on the computer from the Desktop. There are two types of icons:

® Windows 10 Icons: theyare the icons of the programs and applications that
come with Windows 10. Examples of these icons are “This PC”, “Control Panel”,
“Recycle Bin”, the personal folder (my folders).

¢ Icons of Other Applications and Programs: they are the icons of the pplications
that the users need and install on the computer and appear directly on the

Desktop. Examples of Desktop icons are the Recycle Bin and the Control Panel
asin Fig. 8 -5.
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e Control Panel:

Definition of the control panel:it is a folder through which the user can control
all computer hardware and software and change the device settings through
which it can do many tasks such as removing programs and changing the device
language and these tasks will be detailed in a later part.

¢ |con of Computer:

The icon of “This PC” is an icon that enables the user to view all the storage
units on the computer such as hard disks and floppy and compact disks. Fig. 8 -6
shows the window of “This PC”.
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e Recycle Bin:
Skill 8 -10

Restoring deleted files and folders from the Recycle Bin
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The Recycle Bin is the place where the deleted files and folders are sent. From
the Recycle Bin, it is possible to restore the deleted files and folders if needed. Fig.
87- shows the contents of the Recycle Bin.

= [ = = lan=ge Recycle 8in
Home Share View I ﬁc‘i(l( Bin Tools I

4+ @& > Recycle Bin

## Quick access
B Desktop =
elearmin
<4 Downlcads 2

=] Documents

AR SR RS

&= Pictures
abs
Fig
=64
el Dhlge
- CneDrive

El This PC
“3 3D Objects
Bl Desktop
5] Documents
<4 Downicads
D Music
&= Pictures
B Videos
‘a=e Local Disk (C:)
- D (E2)

i Network

To restore a file or a folder from the Recycle Bin, right click on the file or the
folder as shown in Fig. (8- 8), then select “Restore”.

= = = Manage Recycle Bin
Hame Share View Recycie Bin Tools

4+ & > Recycie Bin

B Desktop ‘_)%,

3 Downlcads

|%=] Documents

AAA

= Pictures
abs
Fig | Properties
=63
sl Dllge

& OneDrive

Bl This PC
“3 3D Objects
B ODcsktop
[H Documents < Click to Restore )
3§ Downilocads
D Music
= Pictures
B videcs
e Local Disk (C:)
- D (E)

= Network

To permanently remove a file from the computer, go to the Recycle Bin, right
click on the file and then select “Delete”. You can delete a file or a folder from
anywhere in the PC permanently without sending it to the Recycle Bin by selecting
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the file or the folder and pressing “SHIFT + DELETE”.Showing/Hiding the Desktop
Icons:

Skill 8 - 11

Showing or Hiding Desktop Icons
¥

The Desktop icons might be hidden. To display them, follow the following steps:
1- Right Click on an empty place on the Desktop. A window will appear as
shown in Fig. 89-. Select “Personalize”.

Sort by
Refresh

Paste

Paste shortout
@ Manage OneDrive backup
@ Grophics Propedies...
@ Graphics Options

New

2] Display settings
& Personalze

2. Settings>Personalization window will appear. Select “Themes”. Select
“Desktop icon settings” as shown in Fig. (8- 10).
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3. Select the icons you want to display on the Desktop as shown in Fig. 811-.

& Desktop Icon Settings X
Deghtop lcons
Desktop icons
£ Computer £ Recyde Bin
4 User's Fles M Control Panel
A Netwodk

* 3@ 49

Ths PC ODAI Network chﬁd‘e&'\
)

MAGABLEH
Q-
Pecycle Bn
fampty)
4 Alow themes to change deskdop icons

[ox ][ cmd | [

4. Click “OK”. Also, you can change the icons from the previous window.
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8 -5- 3 Changing the Desktop:

For DesktopPersonlization, follow the following steps:

1. Right click on an empty location on the Desktop. The options window will
appear. Select “Personalize”.

2. The “Settings> Personalization” Window will appear. From this window, you
can personalize the Desktop. For Example, you can change the Background,
the Colors, the Start, the Taskbar, the Lock Screen, the Themes, etc.Changing
the Desktop Background:

Skill8-12
Changing the Desktop Background

i

To Change the Desktop Background, follow the following steps:

1. Right Click on an empty location on the Desktop, the options of Desktop
will appear. Select “Personalize”.

2. the “Settings” window will appear. Click on “Background”.

3. Select the suitable Background. A window will preview the Background as
shown in Fig. 8- 12.

imng

@ Home Background ¢ |

| Finaa seming | 2

—
= |

P = B

Backgroond

03 Lock screen 1 Background 5 3  Background Options

R Themes | Picture
% Fontx
Chaote you pecture
B St
& lkbat P
Browse
Figure 8-12: Chiscke »
Changing | s
Desktop 1
Background
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e Changing the Colors:
To change the colors of the menus, follow the following steps:

1. Right Click on an empty location on the Desktop. Options menu will appear.
Select “Personalize”.

2. The “Settings > Personalization” window will appear. Click on “Colors” tab,
then select the desired color as shown in Fig. 8- 13.

Settings
@ Home Colors
Fce 556y Al Choose your accent color
Personalization D Automatically pick an accent color from my background
& Background Recent colors
€ Colors 1 .....
y

2
[ Lock screen M Windows colors
Selecting
@ Themes Color
o _HEEEE B
= " N EH N

Changing
Desktop
Colors Y

Custom color

e Changing the Lock Screen:

Skill 8 -13
Changing the Lock Screen

i

To change the Lock Screen, follow the following steps:

1. Right click on an empty location on the Desktop. The options menu will
appear. Select “Personalize”.

2. The “Settings” window will appear. Click on the “Lock Screen” tab. Then
selected the desired Lock Screen.
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3. Select the suitable Background for the Lock Screen. The preview will appear
on the upper window as shown in Fig. 814-.
4. Click “ON” to apply the desired Lock Screen.

Settings

3 KPreview Lock Screen }

@ Home Lock screen
Find a setting I Preview
Personalization
B Background
€ Colors
[3 Llockscreen |@—— 1

Lock Screen
@ Themes Option

Background
M Fonts —

I Windows spotlight (@4_1_ 2
B Starnt
Lock Screen Options

= Taskbar Choose one app to show detailed status on the lock screen

Choose which apps show quick status on the lock screen
Figure 8-14:
Changing the
Lock Screen

e Display Settings:

Skill 8 - 14
Adjusting Display Settings

The option of the display settings enables you to adjust the screen resolution
and make it easier to read what appears on the screen. To adjust the display
settings, follow these steps:

1. Click on an empty place on the desktop with the right mouse button to
display the Desktop Options window and choose “Display Settings” as
shown in Figure (8- 15).
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View

Sort by >
Refresh

v

Paste
Paste shortcut

Undo Delete Ctrl+Z
& Manage OneDrive backup ‘
88 Graphics Properties...

Graphics Opti . .
2 e ot " | Display Settings

New p Option
23 Display settings |-t

Personalize

2. A “Settings” window will appear from it. Click on the “Display” option, and
through it you can control (color, scale, reselution, orientation, layout,...).
See Figure (8- 16).

Settings Controlling of Display 3
Options Y

@ Home Display
Find a setting pol ' Color
System Night light
@ of
= Display Night light settings
%) Sound Display
Options Windows HD Color
[ Notifications & actions
Get a brighter and more vibrant picture for videos, games and apps that
a support HDR.
Windows HD Color settings
() Power & sleep
Scale and layout
= Storage
Change the size of text. apps. and other items
@B Tablet I 100% (Recommended) v l
Ei Multitasking Advanced scaling settings
& Projecting to this PC Display resolution
I 1366 x 768 (Recommended) v l
Display orientation
l Landscape v \
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3. For example, to change the resolution settings by increasing or decreasing
the number of colorpixels per square inch, left-click on the resolution box.

4. Adjust to the resolution you want to change the appearance of the screen,
see Figure (8- 17).

@ Home Display
Lo g lu,\/\“
Find a setting p |
Change the size of text, apps, and other items
System ’ 100% (Recommended)
Advanced scaling settings
&3 Display
Display resolution
4 Sound (| resolution ) ‘
[J Notifications & actions e
2 1440 % 900
Focus assist
=2 Select
1400 x 1050 Optimal
O Power &sleep Resolution
1386 768 (Recommenced)
= Storage .
1360 768 rpatically. Select Detect to
@ Tablet
1280 % 1024
HE b 1230 960
& Projecting to this PC 1280 « 800
Figure 8-17: |24 Shared experiences 1280 = 768
Adjusting
Resolution
) Ciipboard
8 -6 Taskbar:
Skill 8 -15

Recognizing the settings of the Taskbar

The taskbar is the bar that runs along the bottom of the desktop screen, in
which active windows appear on the desktop, and it contains several items the
most important of them (language selection buttons, clock and date buttons,
volume control, and the Start button).

To show taskbar settings,follow the following steps:

1. Right-click on the taskbar. A window will appear with several settings for the
taskbar, then click on the task manager option as shown in Figure (8 -18).
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Toolbars >

Search ?
v Show Cortana button
v Show Task View button

Show People on the taskbar

Show Windows Ink Workspace button

Show touch keyboard button

Cascade wandows

Show windows stacked

Task Manager Option )

Show the desktop

Task Manager

Lock the taskbar

0 Taskbar settings

2. The “Task Manager” setting enables you to end any active task on the
computer by selecting the task and then clicking End task.

e Moving the Taskbar

Skill 8 -16
Moving The Taskbar

Ll

To move the taskbar, follow the next steps:

1. Right-click on the taskbar and ensure that “lock taskbar” optionis not
enabled in the taskbar settings

2. Hold down the primary mouse button, and then drag the mouse pointer to
the place on the screen where you want the taskbar.

3. The taskbar will take its place in that area of the desktop screen, see
Figure 8- 19.
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Taskbar in a New Position

e Changing the Taskbar Settings

Skill 8 -17
Changing the Taskbar Settings

i

To change the taskbar, follow these steps:

1. Right-click in an empty place on the desktop and choose “Personalize.”

2. A “Settings” window will appear from it, click on the “Taskbar” settings.

3. Make the appropriate change you want to the taskbar settings, see Figure
8- 20.
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Settings
@ Home Taskbar
Find a setting > I Lock the taskbar
@D on
Personalization
Automatically hide the taskbar in desktop mode
On
B Background -
Automatically hide the taskbar in tablet mode
B coon @ on
C3 Lock screen Use small taskbar buttons
@D on
@ Themes
Use Peek to preview the desktop when you move your mouse to the
Show desktop button at the end of the taskbar
A Fonts
@D o
58 Start Replace Command Prompt with Windows PowerShell in the menu
when | right-click the start button or press Windows key+X
=9 Taskbar I gD o
T Show badges on taskbar buttons
1 Taskbar Option @ o
Fig“-re 8-20: - - Taskbar location on screen
Hide/show (Optlons of Taskbar Settmgs) 2. )
Taskbar | Bottom

After learning about the taskbar settings, some of these settings can now be
changed, for example temporarily hiding the taskbar from the desktop screen as
in the following steps

¢ Hiding the Taskbar from the Desktop:

Skill 8 - 18
Hiding The Taskbar

i

To hide the taskbar, follow these steps:
1. Right-click in an empty place on the desktop and select “Personalize”.

2. A “Settings” window will appear from it, click on the “Taskbar” settings.

3. Turn on the option “Automatically hide the taskbar in desktop mode” see
Figure (8- 21).

4. The taskbar will disappear from the screen and you can restore it by moving
the mouse over the bottom of the screen.
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Settings

@ Home Taskbar

l Find 3 setting e I Lock the taskbar
@D or

Personalization

2 Automatically hide the taskbar in desktop mode
Bd  Background : - o-
cko Hide Taskbar
OptiOl‘lS (ON/OFF) Automatically hide the taskbar in tablet mode

% Colors @D on

C@ Lock screen Use small taskbar buttons
@ on

@ Themes
Use Peek to preview the desktop when you move your mouse to the
Show desktop button at the end of the taskbar

S @

Off

8 Start Replace Command Prompt with Windows PowerShell in the menu
when | right-click the start button or press Windows key+X

=  Taskbar Q On

T Show badges on taskbar buttons
@ o
. . 1 Taskbar
F'_gure 8-21: Taskbar location on screen
Hide/ show
Taskbar l Bottom

8- 7 Working with folders and files
In this section we will explain:
How to use the file explorer program known as Windows Explorer?

e How to save files outside the computer, for example on the Internet via
OneDrive.

e How to recover and save files and learn how to create, save, change and
rename the folder.

Currently we do not have to deal with the system on the default settings for
Windows, so one of the changes that the system user may want is to manage
folders, for example when clicking on the (File Explorer) icon in the taskbar, the
Quick Access folder opens but some users prefer to enter (This PC) window instead
of the Quick Access.

e How to add folders or files to the Quick Access folder in order to facilitate
access to them, especially if these files are the most used and their access
require opening a lot of other folders.

Introduction to Computer Skills 225 -




Introduction to
.............................................. Computer Skills

8- 7 -1 How to Browse Files:

Skill 8 -19
Using start and File €xplorer Buttons

The file is a collection of data that is stored inside the storage media (hard disk,
CD, or flash memory) and has different extensions (such as Excel, Microsoft word,

etc.) and the user can deal with it either by restoring, modifying, deleting, sharing,
or Print them out.

Through File Explorer, you can managethe storage areas on the computer,
allowing you to copy, move, rename or delete files. To open File Explorer, click the
Start button as shown in Figure 822-.

—— Recently added Productivity
B Office Tab Center 2013-16
B Office Tab Center 2013-16(Admin) g
m Visio 2016 Office
Expand
- e -l
@ 3D Viewer Microsoft Edge Photos
A Explore
:

Acrobat Reader DC
New

- Alarms & Clock ﬁ
Avast Free Antivirus Microsoft Store
New

c t

Figure 8-22:
Showing the

Start Button FES Excel 2016
£ [rype here to search

0
=
@
]

Then we choose from the Start menu file explorer button, or by pressing the
windows IE0 +E buttons as in Figure 823-

Figure 8-23:
File Explorer
Icon

- 226 Introduction to Computer Skills




S Part Chapter @
® Practical Part®
e 2- Windows 10

8- 7- 2 Dealing with quick access window and internal media

Skill 8- 20
Learing the dealing with Quick Access window and
Internal Media

i

When you press the button in Figure 823-, the Quick Access window appears
to us through which all the file explorer windows can be displayed and browes
all the files and folders that have been worked with recently or frequently as in
Figure 8- 24.
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When you click on “This PC” icon located inside File Explorer, it shows all the
secondary storage media through which you can find the file that we want to work
on as in Figure 825-.

This PC
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B
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=

We also find that the information displayed in the window of this PC helps you

to access the files or folders you want.
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8 -7 -3 File Types:

Skill 8- 21
Learing about the most important Types of Files

There are many types of files that can be created within the Windows 10
operating system. Each type has its own formatting that defines from the file
extension and on creating any file the type is chosen at the beginning, thus
the operating system places the extension automatically, and the file extension
determines its type, and it usually consists of three or four Characters in English,
separating the filename with a dot (.)

Example: on creating a microsoftword file, the two sections appear to us as
in Figure 8- 26. The operating system asks to type the name of the file the user

desires. When writing the file name, the following should be considered:

- Filename must not exceed 219 characters.
- Filenamedoes not contain special signs like +, /, *, ... etc.
- Filename name can contain numbers

(  File Extension -

Figure 8-26:
File Name and W
Extension

BEBrshatdadoaoc<

C File Name ) 2

Table 8- 1 shows examples of the most common file extensions.

Table 8- 1 Examples of the most common extensions

1 Word Files DOCX, DOC, TXT

2 Power Point Files PPTX, PPT

3 Excel files XLSX, XLS

4 Access Database Files ACCDB, MDB

5 Audio Files WAV , MP3

6 Video Files AVI, MOV , DAT

7 Photos BMP, JPG, GIF, PNG, TIFF
8 Executables files EXE, COM

9 Adobe Acrobat file PDF
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8 -7- 4 Creating Files

Skill 8- 22
Recognizing the Creating and Renaming of Files

There are several methods to create files, for example:

1. The traditional method: files can be created directly from their own programs
by entering the Start menu and choosing the specific program.

2. The Fast Way: There is a fast way to create a file in some programs, including
setting a shortcut to create its files in a fast way on the desktop, as follows:

e Weclick the right mouse button on the desktop or in any folder in an empty
place, as in Figure 827-.

e We choose from the sub-menu that appears (New).

* Another submenu appears from which we select the desired file that we
want to use, for example (MS Word).

( Select New Word File

View
Sort by
Refresh

Paste
Paste shortcut
Undo Delete
& Manage OneDrive backup

83 Graphics Properties...
B3 Graphics Options

| New Folder
3 Display settings U ticaten

&8 Personalize & Bitmap image

|ﬂ‘ Microsoft Word Document
§*| Microsoft PowerPoint Presentation
@ Microsoft Publisher Document

£33 WinRAR archive

'] Text Document

87 Microsoft Visio Drawing

0 Microsoft Excel Worksheet

23 WinRAR ZIP archive

v)
]

* The required file will be created and given a default name that can then be
modified.
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8 -7- 5 How to create a Folder

Skill 8 - 23
How to creat a Folder on the Desktop

i

To store new data inside a folder, you can create a new folder by following
these steps:

1. Open the place where you want to create the folder using the Windows file
browser, as in Figure 828-.
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2. Right-click on an empty space as shown in Figure 829-.

3. Choose “New” from the pop-up menu. A sub-menu will appear for you.
Choose “Folder” from the top of the list, as shown in Figure 829-.
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4. The folder will be created, and the operating system will assign its name by
default, as in Figure 830-.
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8 -7- 6 Editinga File or a Folder Name

Skill 8 - 24
€diting a File or Folder Name

There are several methods to edit a file or folder name:

The first method:we select the folder or file whose name is required to be
modified, then we single-click on the name of the folder or file and we write the
new name and then press Enter or click the left mouse button outside the name
text box.

The second method: we select the folder or file whose name is to be modified,
then from the keyboard we press the F2 button and write the new file name and
then press Enter

The third method: right-click on the folder or file whose name is requested

to be modified as in Figure 831-. From the sub-menu that appears we choose
(Rename), type the new file name and press Enter.
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8 -7 -7 Deleting a File or a Folder

Skill 8 - 25
Deleting a File or a Folder

A file or folder can be deleted in several methods:

The first method: we right-click on the file or folder required to be deleted. Then
we choose from the sub-menu that shows a delete command as in Figure 8 -32.
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A confirmation message to delete the file or folder appears as in Figure 833-If
we want to delete the file, we press the Yes button, and if you withdraw the idea
of deleting, press the No button.

Delete File X

Are you sure you want to move thas file to the Recycle Bin?

» Book1
=g | Type: Microsoft Excel Worksheet
R Authors: ODAI MAGABLEH

—— Size: 6,02 KB

e | Date modified: 7/11/2020 2:21 AM
i S
Figure 8-33: —
A Confirmation
Massage o e

Delete File

The second method: we select the file or folder to be deleted, then press the
Delete button on the keyboard

The third method: We drag the file or folder to be deleted to the Recycle Bin.
In this way, a warning message does not appear. The deletion is done directly

8 -7 -8 Saving Files in the OneDrive by default in Windows 10

Skill 8 - 26
Saving Files in the OneDrive

Many of us want to keep their files in a place that guarantees their safety, so
we find that in Windows 10 it included setting a default location called “OneDrive”
to store the files as in Figure 834-. We find that the default setting is to save files
to OneDrive, instead of saving them to the computer. This means that you will be
able to access these files from any other device by connecting to the Internet.
These files will also be protected in the event of damage to your computer. You
can also change the “default save” setting at any time later.
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8 -7 -9 Selecting the location to save your files
By default, we can change the location where files are saved as following:

1. At the bottom of the Windows10 screen, as in Figure 835-, we right-click
the OneDrive icon and click Settings.

.( How to Save Files on OneDrive )

@ D B52PM
A Bz NG e [

(_OneDrive application on taskbar )

2. In the Settings box, on the AutoSave tab, under Documents and Pictures,
click the list in Documents or Pictures and choose the default save location
you want.

8 -8 Search for files and folders in Windows 10
8- 8- 1 Searching through the search box in Windows

The Windows search box function, located next to the Start button, is to help
you find files on your device, hidden settings, or even hidden items or websites.

To find the missing items, follow these steps:

Skill 8 - 27
Using the Search Box next to the Start Button
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1. Type what you want to search for into the search box next to the “Start”
button

When you start typing, Windows immediately starts looking for items match
what you’re writing. For example, here is what happens when you search for
files of the Computer Skills Course on your computer: When you start writing
the words, Windows begins to display files or links matching the words that are
written, as shown in Figure 8- 36 after writing only the word “skills”, you will see
several files on your computer about the Computer Skills course (of course these
files have been stored on your computer before).

—

( Search Categories)

Best match for documents
m skills- Word
Adobe Acrobat Document
Last modified: 7/11/2020. .05 PM
B8 | Documents - This PC
= computer skills-OS > | | Search Result
! ] computer skills-Programming N
Languges
[ computer skills-Exual >
] computer skills-Vauris >
& (5| computer skille BlackBorad >
X computer skills-ProPoint >
3 computer skills-Windows >
e | computer skills-Introduaction >

£ documents: computer SRI"S‘ N I" .

W@ ~ O = © . B = ( SearchBox

At this point, the search box focuses on the speed, so it only searches for
matching file names stored on your computer. If you find what you are looking for
has appeared in the search box, you can go directly to step 3. If you still did not
find what you are searching for and have completed your full search statment, you
must follow the next step to refine your search in a more concise form.

2. Determine the search on the computer or the internet

On startup, the search box only searches for matching file names. If it does not
find matching names, it directs the search to one of two categories at the top of
the search list (along with filters):

Introduction to Computer Skills 235 -



Introduction to
.............................................. Computer Skills

e My Documents: Choose this category to restrict the search to items only
on your computer. A window appears, as shown in Figure 838- with the
results listed in a scrollable list. If you also see many items, you can narrow
your search by clicking on the word Filter above the list, and choose one of
the categories from the drop-down menu: All, Documents, Folders, Apps,
Settings, Photos, Videos, or Music.

e Web: Choose this category to stop searching through the computer and
instead directs the search directly to the Internet. Your web browser opens
web pages that match your search. See Figure 837-, for example, when
searching for Sheikh Al-Islam Ibn Taymiyyah, you will see several links that
talk about the Sheikh once the first words of the search term have been

written.
AppS Documents Web More wig 4
Selecting 4 A
the Search Best match for web Different
within the computer skills g’lt.ers
Web, Files, ptions
' - See web results
Applictions Search the web
2 computer skills online learning - <e« >
web resulits
£ computer skills cv >
Search Result
£ computer skills for resume >
= O computer skills placement practice >
test
£ computer skills to list >
O computer skills for seniors >
£ computer skills to list on application >
Figure 8-37:
Using the
Search Box
Besides the <3 1
Start Button to O web: computer skills|
Search the = The
Web = 2 o =1 = - B == Search
| \ Statement J

3. The selection of the item that matches your search to be opened and
displayed on the screen.

Click on the file that matches your search directly from the list and it will open
in the application corresponding to the file type. You can also find the location of
the file on your device by right-clicking on the file in the list and you will find the
phrase “Open file location”, which indicates the location of this file on your device.
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To get the most out of the search feature:

For more speed in thewindows search tool, the search box lists files that
contain only names match your search term. While this strategy sometimes
helps you to find quick matches, you will not find what you are looking for
accurately unless you complete your search statement, then choose the
search scope if you want files on your device or links on the Internet.

Do not press (Enter) after typing in the search box. If you do this, Windows
will call the first item in the search menu, which may not be what you want.
Wait to see what matches your search, then click on the file or link you
want.

The Windows search tool scans every file in your documents, music,
photos, and videos, which makethe storing of your files in those folders
more important than ever.

Windows Search Tool also scans every file you store on OneDrive, even if
these files are not stored on your computer as well.

Windows does not search for files stored in removable devices, such as
flash memory, CDs, DVDs, or portable hard drives.

If you are searching for a common word and the Windows search tool
checkedtoo many files, you can limit your search results by writing a short

phrase for the word you want. The more words that you write, the greater
your chance to define a specific file.

Skill 8- 28
Using the Search Box in Windows Browser for Files

(il

8 -8- 2 Search through “search-box” of the files browser

The results of the search tool in Windows can be excessive when you search
within one folder on your device, as you search for a missing file inside only this
folder. To solve this problem, Windows includes a search box for each folder

through the Windows files browser. This search box limits the search to the files
within this folder.

To find a missing file in a specific folder, click inside the folder search box and
startwriting a short word or phrase that indicates your missing file. Once you start
writing letters and words, Windows starts filtering files inside your folder and
continues to narrow your search until it displays a few files inside this folder as
shown in Figure 8 -38.
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When the search box of the folder identifies a large number of possible
matches, enter some other utilities through the “Refine” tab at the top of the
filesbrowser to determine the best results. For example, select the option “date
modified” to get the most recently modified files at the beginning, as shown in
Figure 839-.
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8 -8- 3 Search through Cortana digital assistant

Skill 8 - 29
The Use of Cortana Digital Assistant of Windows 10

i

Windows 10 includes a friendly personal digital assistant called Cortana.
Cortana is trying to simplify your life by finding not only your lost files, but also
some information about you and your surroundings - for example, local weather
updates, traffic information around your home, or perhaps a list of popular
restaurants nearby. Cortana can even remind you of important dates and events.
In fact, you can meet Cortana: because it is the mind next to the search box of the
Start menu.

Cortana is constantly listening through the microphone on your computer
and waiting impatiently for the term “Hey Cortana”. When Cortana hears these
two words, it listens closely to the search statement and begins processing your
request, as shown in Figure 840-.
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Unfortunately, Cortana is not activated in some geographical regions, but you
can use it if you change your geographical area and language in Windows settings
to the United States of America and the English language, for example.

Cortans - =] x

O

Hi there

Talk to me by typing in the text box or
lect the microphone icon 1o L

Here are some things | can help you do

ﬂ Stay on track
Remind me to update the status report every Friday at
3 PM

MMM Plan ahead

1
— What's next on my colendar? Search Box by
Text
Get started quickly

Open Calculator

2
What's my day hke tomorrow? Open Excel Tell fne an armimal fjct >
Figure 8-40: Y Search by Using
Cortana Microphone
Digital MscCortana e
Assistant —_—
Window ® S O H - A m =0
8- 9 Windows Personlization through Control Panel
Skill 8 - 30
|dentifying the Two Control Panels in Windows 10
s

Windows 10 has two control panels that you can switch between:

e Settings:Settings can be accessed easily with oversized buttons. These buttons
are now available with many other buttons that you may miss lots of operations
without it.

e Control Panel: The control panel from the previous Windows version is still the
same as in Windows 10.

Now, you do not have to disturbance from multiple buttons and the need to
switch between two ways to access the required settings and enter the various

- 240 Introduction to Computer Skills




S Part Chapter @
® Practical Part®
— 2- Windows 10

menus to find a way to change the settings of an application or attached device.
Simply follow these two steps to get what you want:

1. Click the Start button, or click the adjacent search box, and type the search
word describing the desired Setting. When writing the first letters, each
Setting containing those letters will appear at the top of the search box menu.
If you do not know the exact name of your setting, start typing the keyword
like display, mouse, user, privacy, or something that describes your need.

2. Click the desired setting on the list. Windows takes you directly to the
appropriate component for this setting in the control panel, as in Figure
8- 41 to search for mouse settings.

Al Apps Oocurmenty Vewl) Mo »
[—

Best makch

Mouse settings ] Mouse Settings as a
0 yvtam reteg — @ [ Search Result

Mouse settings
(J Change your mouss settings > ot sekting
¥ Change mouse pointer size >

] Change how far you scroil with the £T Open
mouse whee!

R 3605 e e Gt quick help from web

£ mou - see wet resuts > Troubhihootng Ty mouse

- 1
Figure 8-41:
Searching for

Mouse & | P rodeoe omE}.‘Q‘ﬂ“

Settings

8 -9- 1 The Settings

Skill 8 - 31
Working with the Settings in Windows 10

To open the Settings, click the Start button and click the word Settings near
the bottom of the left pane of the Start menu. The Settings appears, as shown in
Figure 8- 42. In fact, the Settings look almost identical towhether you’re watching
Windows 10 on a computer, tablet, cell phone, or even on a TV set.
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Windows10
Settings

The Settings divide into the following categories:

e System: This huge category combines all settings related to the computer
system. For example, you can find ways to adjust the screen, set the notification
and events, adjust the power, storage units, etc., and even you find settings for
how the Maps app interacts when you disconnect from the Internet.

e Devices: In Windows, devices are your physical items like a mouse, keyboard,
printer, scanner. Thus, this field allows you to set the scroll wheel of the mouse,
as well as how the computer interacts when inserting a memory card. Briefly,
it is a mixture of settings that you find mostly by searching in the search box of
the Start menu.

e Network and Internet: The settings for a Wi-Fi network on your default
network are through the establishment of mobile internet connections, and
others related to network and internet settings, you can find them all in this
category.

¢ Personalization: |n this category, you can choose a new desktop or screen lock
photo, and the welcome’s photo when your computer starts up. You can also
customize parts of the Start menu, etc.

e Apps: In this category, you can add or remove an application, and you can
change application settings or move them from the device to a secondary
storage medium, etc.
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e Accounts: Here in this category you can create or change accounts of users
use the computer, as well as to delete the accounts of those who are no longer
welcome to use the computer. This category also allows you to change the
password or account picture. If you are working on more than one computer,
you can go to the Sync Your Settings section to control which settings should
be linked to your Microsoft account.

Time and language: Often you enter this category once at the start of setting
up your device and forget about it afterward. It allows you to change your
own time zone, adjust the time, date, and the corresponding formats for your
region and set other settings related to your language and geographic location
when the region changes.

Ease of Access: These settings make Windows more suitable for persons with
disabilities in vision and hearing.

Privacy: Unfortunately, in this era, there is a little space of privacy left for us on
the Internet! However, this section allows you to see the controls that Windows
provides for you to limit the information that apps and websites gather around

you. For example, you can control the apps that can access your site and control
the camera, as well as those that can see your contact list.

Update and security: You can often enter this category to set up your file to

determine the backup date. Also, to familiarize yourself with the recovery area
which provides powerful tools for troubleshooting.

8 -9 -2 Desktop Control Panel

Skill 8 - 32
Working with Control Panel of Windows 10

Although Windows 10 greatly supports the settings, sometimes you may
need the control panel. This is because the Desktop Control Panel allows you to
open Windows icons and setting tools. Part of the control panel’s attractiveness
and power is because it has about 50 icons, and some icons require menus with
dozens of settings and tasks. It is also familiar because many of its settings have
not changed in more than 20 years.

To open the Control Panel on the desktop, right-click the Start button and
choose Control Panel from the pop-up menu.
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To avoid searching for a long time to obtain the correct control icon, the control
panel groups similar elements together under one category icon, as shown in
Figure 8 -43.

Like Settings, the control panel monitors the search box in the upper-left
corner to find settings that deal with a specific topic. If you move your mouse
pointer over a main category, the control panel describes the settings available
within that category.

wn
=

1 (ot ed

Tyre — ]
The Search box 1
with Control Panel

LA o8 o o P e € A
AN YOU! COmpuEr § S80S

2
Elements of The
Control Panel

Some setting icons may not fall neatly within a category, even they may not be
included in any category. To see each icon provided by the control panel, choose
either large or small icons from the drop-down menu next to the word “View by”,
as shown in the upper right corner of Figure 844-. The window quickly displays all
control panel icons.

Figure 8-43:
Control Panel
in Windows10

The contents of the control panel may vary from device to device, as shown in
Figure 8- 44. Because different programs and other computer accessories often
add their own icons to the control panel. Also, different versions of Windows
may also have slightly different icons. Leave your mouse pointer over any icon or
category in the control panel, and Windows will explain its meaning.
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8- 10 Add or Remove Apps or Programs
Skill 8- 33
Add, Remove or Modify Apps and Programs in
Windows 10 =

Removing the application from your Start menu does not take much effort.
Just right-click the app name from the Start menu and choose Uninstall from the
popup window. But this procedure does not completely remove the app from
your device! Rather, the application is removed only from the Start menu.

To completely removethe app or program from your computer, follow these
steps:
e Click the Start button and choose Settings from the menu, the Settings will
appear.

e Click the App icon, when the app’s window appears, click Apps and Features at

the left pane of the window. The Installed Apps and Features window appears,
as shown in Figure 8- 45, where the currently installed apps and programs are
listed according to size.
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To sort programs by installed date, click the “Sort by” button and choose
“Installed on” from the pop-up menu.

e C(lick the program you want to remove, then click the Uninstall or Move button.

Depending on which button you click on, Windows either removes the program
or app from your computer or moves it to another drive or memory card.

- In case of using a tablet, click on one of the listed programs, and two buttons
appear below it:

® Move: When your storage space is exhausted, choose this option. It allows you
to move the app or program from your tablet device to the memory card, and
free up space for your files.

e Uninstall: Click on this button - then on the Confirm button - to completely
remove the app or program from your computer.
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Skill 8 - 34
Adjusting Time and Language Settings in Windows 10

8- 11 Time and Language Settings

Microsoft designed the time and language area mostly in the settings for
travelers to different time zones and other locations. Users of desktop computers
usually see thisinformation only once when first setting up the computer. Windows
later remembers the time and date even when your computer is turned off.

As for users of laptops and smart devices, they will need to enter that region
when visiting different time zones at a universal time. Computer users will also
enjoy the bi-lingual computer feature, with settings that allow characters from
different languages.

To change language and time, click the Start button, choose Settings from the
menu, and click the Time and Language category. Three sections appear as in

Figure 8- 46:

Settings

@ Home Date & time

[ Find 3 setting . ] Current date and time

| Time & Language 10:04 PM, Saturday. July 11 2020
Set ime automatically !
| @ Date & time

@ o Set Time or Region

® Regon Set time 2008 automatically Zone Automatically
@ on

A¥ Language
Set the date and tme manually

0 speen T Change

3 Synchironize your dock
Region and Language
Options Sync riow
Tame 70ne
(Changing Time Zonej ) —>| | (UTC+0300) Kuwait. Riyadh
Figure 8-46:
Date and Time
Options 0
in Windows10

Show additional calendars in the taskbar
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 Date and time: This area is somewhat self-explanatory. (it allows clicking on the
taskbar clock and choosing to change the date)

e Region and Language: If you are bilingual or multilingual, move to this area
when working on documents that require letters from different languages.

Use the control panel with your laboratory teacher to perform the following

tasks:
1.

N R W
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Create a new user account on your device.
Change your profile picture and password.
Change your desktop wallpaper.

Handle the selection of a screen saver.
Change the themes of the computer.
Change the screen resolution.

Adjust sounds and its intensity.
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N

v

Microsoft Word 2016

@ Main objectives:
1. Dealing with Microsoft Word2016

@) Sub-Objectives

It is expected from the student after studying this chapter, to master the
following knowledge and skills:Recognize the operating systems and their main
functions and types.

|dentifies word2016 interface elements.

Creates a new file in Word 2016.

Recognizes and deals with Wordtemplates2016.
Knowshow to manage and edit documents.
Knowshow to view and print documents.

Knowsabout the basic editing processes and patterns.
Knows searches and inferences.

Knows the insertion of the head and the tail of the page.
Knowsinseration of illustrations graphs

Recognizes the inclusion of shapes and symbols.
Master the insertion processes of Tables

(D 00 ) O

e
= o
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9 -1 Introduction to Microsoft Word 2016:

Microsoft Word 2016 is one of the most important programs produced by
American Microsoft company for text processing, and it is used by millions
of users around the world to manage office business by providing the latest
editing and auditing tools for writing documents, messages, researches, and
coordinating various processes on them and preparing them for printing, sharing
or transmitting.

Microsoft Word Features 2016:
Word 2016, the latest version of the word processing software package, it
has many of features, including:

1. Co-authoring with anyone anywhere: It is possibleto co-work on the same
Word document at the same time as a manyof people who can edit the
document and co-output it.

2. Share simplified documents: it is possible to shared as well as access to
Word documents saved in SharePoint or OneDrive

3. The ability to send large files using One Drive: The user can save large files
in the OneDrive cloud storage service

4. Smart Search: One of the most important features of Word 2016 is smart
search throughwchicha ward can be identified within the specific document
and then we click the right mouse button to do a search for that word
through Bing search engine.

5. Charts and graphs: A new set of charts and longitudinal and horizontal
squares were more flexible and evolving than previous versions.

6. SKYPE Integration

This feature enables businessmen to use SKYPE from within Word, now you
can answer video calls or messages without having to exit the document that’s
working on it.

9 -2Starts Using Word 2016:
9 -2- 1 RunnigWord Processing Software (Word 2016):

Skill 9 -1
Running the Program from the Start Menu
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To run the program from the Start Menu follow the following steps:
1. Click the left mouse button on the Start button.

2. Alistofall programs and applications installed on your computerisappeared
and click on ‘Word 2016’ as in figure (9 -1), the program will start running.

n Windows Fase of Access

Windows Kits
New

D Winaows Powershell

- Widows Secuaity

n Xptzx Lontole Comparnion

(W xvox Game Bar
¥
Figure 9-1: - Your Mhone
Running MS
Word by

Using Start
Button

866 00

I L3 frype here to scarch

9 -2- 2 Closue the Word Processing Software (Word 2016):

Skill9 -2
Close the Program

i

To close the program, follow the following steps:

e (Click with the left mouse button on the ‘Close’ icon in the address bar at the
top left of the window that ends the program as figure (9 -2)

Close Programs 1

A:800c00 ] A0B2CeN  AaBD wiet AQB simsor womeco

5 Paploce

Figure 9-2:
Close MS
Word
Programs
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9 -2 -3 Components of the Text Processing Window (Word 2016):

SkillS -3
Kowing the Components of the Program Window

Quick Assess Tools Bar | 2 ( Title Bar 1 ( The Ruler ) 1 8 Share Work 9
O . e 51 - Dol m E]

File Menu [ 3

H

-
HomeBar(4 —»| - "7

angaton - ~
Navigation | - s
(i W fe = e _

i
e YUE R :
Horizontal 5
Scroll Bar -
o
:
Bar D ]
.. " -
Figure 9-3: Al ason :
Window of MS .- N
Word 2016 UNIVERSITY Of BISH =
g | s

1. Title Bar: Displays the file name of the edited document and the name of the
program you are using and also includes the usual control buttons (zooming

out, restoring, closing)

2. Quick Access Toolbar: Contains commonly used commands such as (save,
undo and replay) and at the end of the Quick Access toolbar there is a drop-
down menu where you can add other commands that you use or need a lot.

3. File tab: Through which processes are interacted on the document itself and
not with its content (new, open, save as, print, close.)

4. Ribbon: A set of toolbars at the top of the program window after the address
condition to help the user access commands.

5. Work Area: Displays the contents of the document you edit.

6. Horizontal scroll bar: Allows you to change display options by using a scroll
(zoom) to control the size of the document window.

7. Statusbar: Displays information about the document you are editing (number
of pages words, etc.
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8. Intelligent Search: Allows you to search for Word commands, get help and
search the web

9. Work sharing: Allows you to share work with others by inviting specific people
to view and edit archived documents on the cloud.

10. Navigation window: Allows you to navigate document pages and navigate
within the document

11. Rulers: Allows you to adjust the width and length of the page and there are
two horizontal and vertical rulers that can be controlled by showing and

hiding.

9 -2 -4 Create Blank Document:

Skill9 -4
Create Blank Document

To create an empty document, follow the following steps:

1. After opening the program click on the template ‘Blank Document’ with the
left mouse button and a document will be created and opened. If you want to
create a new document in another way, click ‘File’, click ‘New’ and click on the
‘Blank Document’ template, see Figure (9 -4)

Blacnk Decuomant LZ

T :
New
£
Capintmaos Sben (o I  owl pashm  Memen wut D L A
Aa
- Takda tou
-
e S Proesl Dol A= S ~—
— A —
= . =ty e - -
Table of =
contents =
Figure 9-4: -.‘.
Create a New
Document e —.——— e -
. oA YO0€ /O ~oanre NT O
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9 -2 -5 CreateDocument Using Word 2016 templates:

Skill9 -5

Create Document Using Word 2016 templates
¥

There are two types of templates, namely Word 2016 and online templates,
word 2016 templates have been installed and stored on the computer, when
installing the word processing software and the program includes a wide range of
templates enough to get started.

To create a document using ready-made Word2016 templates, follow the
following steps:

1. Click the left mouse button on the (File> tab

2. Clickon <New>window will appear with a number of ready-to-use templates

3. Choose the suitable template for you, for example, we want to choose a
template to create a resume file that we select and then click on «Create>»
as the form (9 -5)

Select Template

c @ n@As A€ Jo

9 -2- 6 Create Document from Online templates:

Skill9 -6

Create Document from Online Templates
L 4

To create a document from the internet, follow the following steps:
1. You must have an Internet connection.
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2. You must have an Office login account and office.com site will provide to
you a many of ready-to-use templates.

3. To search for a template from the Internet choose from the <new> file
tab, then type the name of the template in the <Home page» box as in the
figure (9 -6), then click on «Search» the search results for the template you
selected for example we want a certificate template.

4. Yowll also find templates created by Word 2016 word processing users
who have uploaded their work to share with others.

5. To create a document of online templates choose the template category
online and select the style you want and click on a download.

zoper mer Mot o

(Write the Template Name | 2 (Search Button) 3 (Search Result) 5] ( Category Search 4

New |

| - |@<_‘ l 1
Yooy :

i '1 o

. pra=—— i

NAMETITLE . S :__ e ] D

'_T: e e "f"-‘ Lor b e

Al -

P\ b et * e o et e e e gy o — Setnty ‘

4 == Bo e o | | o=
- oo y '
Figure 9-6: r‘ KEEICATS : ',. — g = 9 f 1= .
Create - l A' - - e oot i ! Com g “wnbutimes ‘ Lt ]
e / — i nirew — |
Document by / ’ - : S :
Using —-J ’ » L2
Internet 7 = &K E—
Template - v et v P —— . o

9 -2- 7 Save Document:

Skill9 -7
Save Document

Newly created documents that usually saved in the name of a particular file
that is closely related to the content of the document so that you can locate the
file as quickly as possible after editing your existing document.You can choose to
save that document in the name of a new file or format a different file, when you
save a document such as the cloud and ‘OneDrive’ you can access this document
on any computer or tablet and can share it with others.
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To save a document in the name of follows the following steps:

1. From the ‘File’ tab click on ‘Save as a Name'

2. A saved dialog box with a name with save place options will appear either
on your PC or on a different place such as One Drive or adding another
place as in figure (9 -7)

e ' ¥ ]

1
Options to Select
Place Saving

Save As

~ Orelrwe - Ao
J ma
+ 2ot s Pixe

Ererns

3. The file save window will appear, in the file name box write the file name
for example computer skills and then choose the type of document (if you
press the save button the file will be saved by the type (docx) and in the
document folder) by default and then close the document as figure (9 -8)

4. Oryou can save from the Quick Access toolbar or quick save by clicking on
ctrl+S keys.

5. Click ‘OK’ to save.

1 Bl « Userz » 96856 » Decktop » vI ] Search Decktop

Organize ~ New folder e )
% Documents Saving Path \ Date medified Type
4 Downloads Al Gl g _— Filr falder
D Munic S computer skilis Write File Name it W
= Pictures
B Vigeos ( File Extension Options ) .—

i Local Disk(C) . o

Fite name: | computer skills ,I

Save as type: | Word Document e

Ao

Weord Macro-Enabled Decument
Word 97-2001 Document

Word Temglote

Word Mocro-Ensbled Termplate
Word §7-2003 Template

~ HMide Folders PO

| XPS Document

Singla File Web Page

Web Page

Web Page, Filtered

Rich Text Format

Plan Text

Word XML Decument

Word 2003 XML Decumeant
Strict Open XML Document
OpenDocument Text
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9 -2- 8 Open Document:

Skill S - 8
Open Document

Word 2016 provides the possibility to open the last files as well as the oldest
files.

1. From the ‘File’ tab click on ‘Open.
2. The navigation part will appear as the figure (99-)

compate bty - Wosd

L) Fecent Today
g comeuter sau B0 S0P
Dodee
CenDrive - Persoral 2
L) odn muQIkAB I sread cov d g:ﬁ;ﬂ‘)lf\f“&nlm(rr!rmn IR0 S0P
e300 » Ll s
Chugites B trans Revised Final Ty
[;] This PC a n:fe.‘:__:?-. ',.. - D
= \Wsal
o Addamece This Week
u Chagter B ans Revsed Final HIVED 84U P
* oyl g s
0
= Test WA 8 AL
2 File Path Options a Desitep i i AS4
1 Select Open Option Last YWeoek
: o 5 jsilygsadall ylsa D TN
Flog:ersi:gg' 3 Advanced Files Option ﬂ Desttey
Document I > Brstu docx TED AP
Deurop

3. Click on the local disk that contains the work files, then double-click the
folder that contains the document, and then double-click to open the
document.

9 -3 Basic EditingProcesses:
9 -3- 1 Select and Edit Text:

Skill© -9
Select Text

You must first select and edit the text to do so follow the following steps:
1. Select text using the keyboard or with the mouse.
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2. If you use the mouse to select the text, click with the constant pressure and
drag of the mouse.

3. If you use the keyboard to select the text click on the SHIFT key and the
appropriate arrow of directions arrows

4. The text will appear shaded (usually in blue) when it is selected as the figure
(9-10)

cheetsU <KX M S T s ABNA Asboax ABMCE AdB e |
Puce vou M7 U mxx R-7-4- -|-]a-3- homs  febtte Ihofpuc. |Pasdng! | rendng? T Sitelm. : p e,

9-1 Introduction to Microsoft Word 2016:
Microsoft Word 2016 is o2 of the most important programs produced by American Microsoft

company for text processing. and it 15 used by mullions of users around the world to manage office
business by providing the latest editing and anditing tools for writing documents, messages,

researches, and coordinating various processes on them and preparing them for prnting, sharing

of transmitting.
Microsoft Word Features 2016:
Word 2016, the latest version of the word processing software package, it has mary of features,
Figure 9-10: including:
Selecting
and Editing 1. Co-authering with anyone anywhere: It is possible to co-work on the same Woed document at the

U same time as a many of people who can edit the document and co-output it.

Deleting Letters and words without being selected using keys:

To delete the letter that precedes the Backspace
writingindicator

To delete the text from the writing indicator to Ctrl+Backspase
the beginning of the word

To delete the letter that follows the indicator Delete

To delete the text from the writing indicatorto Ctrl+Delete
the end of the word

9- 3 -2 Navigation, Search and Replacement:
* Use the navigation tool to find text within the document:

Navigate within the document can be through using the following means:

1. The Mouse

2. The Keyboard

3. Scrolling pars

4. Dialogue box Go to
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e Using Dialogue Box Go to:

Skill©9 -10
Move to Inside the File

To use the move to dialog box follow the following steps:

1. From the ‘Home Page’ tab and from the ‘Edit’ group click on the icon’s
arrow ‘Search’ at the far left of the ‘Home Page’ tab and click on ‘Go to’

2. The ‘Search and Replace’ window will appear from which the ‘Go To” will
appear as in figure (9- 11)

3. Write down the page number to which you want to go.

Find and Replace ? X

Find Replace | GoTo

Figure 9-11: |Ggfo what: _ %nter page number:
Goto a Section S——

SpeC|ﬂC Page g::kmark will move forwand four items.

Comment

Footnote v

l Previous Next Close
—'_
e Search:
Skill 9 - 11

Serach in the Document

i

With Word2016, you can search for a word or phrase within the document,
or search for a specific text and replace it with another text to search for a word
within the document follow the following steps:

1. from the ‘Home Page’ tab and from the ‘Edit’ group click on ‘Search’ icon
2. The ‘Search and Replace’ window will show which choose ‘Search’

3. Type the word you would like to look for, for example, the word (insert) as
in figure (9-12)

4. Click on (Find the Next)
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- ?

Fnd aud Replace Search for a Word or a Sentence) X
Find Replace GoTo

Fin&what: ’Insert v

. ?( Search Inside the File Options )
Reading Highlight~ | FindIn~ | | Find Next | Cancel

]

5. 5.The result of the search inside the document will appear shaded as it
appears in figure (9- 15)
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right mouse uoa to 3> 2 search for that woed Seough Bing search cegine.
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This feanxes csables busgesioxn % wse SKYPE from within Weed, sow vou can
answer video calls or messages without baving to exit the document that's working ca it

2tarts Using Word 2016
921 Rurig Word Prosessing Softwane (Word 2016}

e Replacement:

SkillS -12
Serach and Replace

—3
-~

Replacement is used to search for a word within the document and replace it
with another word, for example, to replace the word ‘pattern” instead of ‘thesis’,
we follow the following steps:

1. From the ‘Home Page’ tab and from the ‘Edit’ group click on the icon
‘Replace’
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2. The ‘Search and Replace’ window will appear from which to choose
‘replace.’

3. In the search box write the word you want to replace

4. In the dialog replaces type the word to be placed instead of the replaced
word as in figure (916-)

5. Click the ‘Search for next’ button where the first appearance of a word that
matches what was written in the search box is selected.

6. Then click the replacement button to replace the word as the figure (914-)

7. There are options for replacement (replace, replace all, search for the next,
cancel the order) you can use as needed for replacement.

1 (Replace Option 2 ( Search for a Word Want to Replace it)
| 1

Find and Replace ? X
Find GoTo

Find what: I m
Options: Search Down
Replace with: I E]
Figure 9-14:
Replacing
a Word More >> HEPIacE REpIacEAll Find ext Cancel

3 ( TheNew Replacement Word ) (4 |(Replacement Options )

9- 3- 3 Cut and Copy and Paste:

Skill 9 -13
Cut and Copy and Paste

I

Cutting, copying and pasting skills are main skills in Word 2016 and to use
these skills we follow the following steps:

1. Select the text you want to copy or cut.
2. Click the cut button or copy from the <Home Page’as in figure (915-)

3. Or you can right-click on the text and choose «Cut> or use the Ctrl + X
shortcut.

4. Click with the right button in the place you want to putthe text and choose
«copy» or use the Ctrl + C shortcut.
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5. Click with the right button on the text and then choose <paste> or use the

«Ctrl+ V.” Shortcut or from the <Home page> tab and from the «Clipboard>
group click the «Paste» button as figure (9- 15)

E (3 - (.5 =
Flgure 9-1 5 File Insert Design Layout References N
Buttons of “[__Bl E‘?{’c”t Calibri (Body) ~|11 ~| A" A" Aa~ | 2e
*E& Copy
P . ~
Cut, Copy Bte o ormatPainter | B I U e x. x* | AW - A -
and Paste Cipboard A - i

9 -4 FormattingProcesses:

Text format is the processes that are made on the text and include (change
the size font and colour, style, and other formats)

9.4.1 Copy Format:

The text format can be copied within the same document or between other
documents.To copy the text format:

1. Select the text that contains the format you want to copy elsewhere.

2. Click the «Copy format> button in the <Home page> tab as in figure (916-)
or you can use the shortcut (Ctrl+Shift+C) from the keyboard to copy the
format

3. The cursor will turn into a drawing brush.
4. Choose the new text and it will take the same old text format.

e 9.4.2 Italic, Bold,Underline:

SkillS -14
ltalic, Bold, Underline

To apply a format (Italic, bold, and underline), follow the following steps:
1. Select the text you want to format.

2. From the ‘Home Page’ tab and from the group’s ‘font’ click on the format
(Italic, bold, and underline) you want as in figure (9- 16)
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Design Layout References

— 36 Cut
0 D EE Copy
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9 -4- 3 changing the Font Size:

Skill 9 -15
Changing the Font Size

To change the font size, follow the following steps:
1. Select the text you want to change the size of its font.

2. Fromthe <Home page» tab and from the group «font> click on the «font size»
icon arrow as in figure (9- 17)

3. Choose the appropriate size of the font and save the document.
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Figure 9-17: “m
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9- 4 -5 Change the FontType:

Skill 9 - 16
Chgange the Font Type

To change the font type, follow the following steps:
1. Select the text you want to change the type of font.

2. From the <Home page» tab and from the group»s «font»> click on the icon
arrow <Font type» as in figure(918-)

3. Choose the appropiate type of font and then save the document.
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9 -46- Change the Font Colour:

Skill9 -17
Change the Font Color

To change the colour of the font, follow the following steps:
1. Select the text you want to change the colour of its font.

2. From the <Home page> tab and from the group <font> click on the «font
Colour <icon arrow as in figure (919-)

3. Choose the suitablecolour for the font and then save the document.
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9 -4- 7 Text Highlight Colour:

Skill 9 -18
Text Highlight Color

In addition to the main font colours, you can also apply the highlight colour
to the text. To apply a highlight colour to the text follows the following steps:

1. Select the text on which you would like to add a colour to distinguish.

2. from the «<Home page> tab and from the group»s «font» click on the icon
arrow «Text Highlight Colour» as the figure (9 -20)

3. Choosethesuitablehighlight colour forthe textand then save the document.

Paste :
. ~ Format Painter

Crobuarg i) Font
& computer skills ~ -

Figure 9-20:
Text
Highlight
Color

9 -4- 8 Remove TextFormatting:

Skill 9 -19
Remove text formatting

Introduction to Computer Skills 267 -




Introduction to
.............................................. Computer Skills

To remove the text format, follow the following steps:
1. Select the text from which you would like to remove the format.

2. from the <Home page> tab and from the «font> group click on the entire
<remove Format» icon arrow as the figure (921-)

3. Save the document.

computar sioll - Word

Paste B - u x H.Ww. s EE=E=E. 2. LD . T Noe
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9- 5 StyleProcess:

Skill 9 - 20
Using Ready made Style

i

The style is a set of formatting properties such as (font type, font size, font

colour, line distance, alignment.... etc.) Styles are used to shorten time by applying
many formatting properties at once.

9- 5- 1 Using Existing Heading Style:

To apply ready-made letter style to a document follows the following steps:

1. Open the document and then select the text on which you want to apply
the letter style.

2. From the ‘Home page’ tab and from the group ‘Styles’, click on share more
styles as in form (9- 22)

3. Click on the style you want and then save the document or keep it open.
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9 -5 -2 Create a New Style:

To create a new style follows the following steps:

1. Open a document and then write a text in a specific style.

Mlcrosoﬁ; Word
AsBbCcDc AaBbCcl AaBbCede |AaBbCc |4asocc AQ B agsbeen:
T Normal Subtitle T No Spac... | Heading 1 | Heading 2 Title Subtle Em...
AaBbCcDt AaBbCcDe AaBbCcDc AaBbCcD¢ AaBbCcDe AABBCCDL AABBCCDLC
Emphasis  IntenseE... Strong Quote Intense Q... Subtle Ref... IntenseR...
AaBbCcDt« AaBbCcDc
Book Title T List Para...
A4 Create a Style
R# Clear Formatting 4_‘ Style Operations )
24, Apply Styles...
Skill 9 - 21
Create a New Style
L 4

2. We select the text and then go to the ‘Home page’ tab go for the ‘Styles’
set click on ‘Create a style’

3. A dialog box with options (style name and style preview) will appear as in

figure (9- 23)

4. Click on OK to create style

Create New Style from Formatting ? >
Name:
s Style Name
Paragraph style preview:
Stylel —>‘1 Style Preview |
[ oK ] | Modify.. | cancel
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9 -5- 4 Change StylesProperties:

Skill S - 22
Change Styles Properties

i

To change the properties of styles, follow the following steps:

1. From the ‘Home page’ tab and from the ‘Styles’ group click on the style
we want to change its properties with the right button of the mouse and
choose ‘edit” as the figure (9 -24)

AaBbCcDc AaBbCcl AaBbceDe  AaBbCe 2asbcel AQB  acsbeen
T Normal Subtitle T No Spac... | Heading 1 | Heading 2 Title Subtle Em...

AaBbCcDt« AaBbCcD:¢ AaBbCcDc AaBbCcD¢ AaBbCcD:¢ AABBCCDL AABBCCDL
Emphasis Intense E... Strong Quote Intense Q... Subtle Ref... IntenseR...

AaBbCcDt  AaBk ™~ ~ ) A

Update List Paragraph to Match Selection

Book Title JT List -
—1 4 Modify...
4 CreateaStyle Select All: (No Data)

Ao Clear Formatti
Al Rename...
4 Apply Styles...
. SPRY Sy Remove from Style Gallery

Add Gallery to Quick Access Toolbar

2. A dialogue box with a style adjustment will appear and has a range of
options. Choose what suits you for adjustment as in figure (9- 25)

Modify Style ? x
Properties
Name: [I.ist Paragraph ‘
Style type: iParagraph
Style based on: { 9 Normal
Style for following paragraph: [ 4T List Paragraph
Formatting
Caiori (B0 8 1 u|
= = = = = = r= = = =
= = = | = = = |12 2 | = =
Microsoft Word 2016 is one of the most important programs producsd by American Microsoft
company for text processing, and it is used by millions of users around the world to manage office
business by providing the Iatest editing and auditing tools for wri
Indent:
Before: 0.5°, Left-to-right, Don’t add space between paragraphs of the same style, Style: Show
in the Styles gallery, Priority: 35
Based on: Normal

[“] Add to the Styles gallery [_] Automatically update
(@ Only in this document () New documents based on this template

[m] | OK I Cancel ]

3. Click on ‘OK’ to change the style properties that have been selected
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9- 5 -5 Delete a Style:

Skill S - 23
Delete a Style

To delete a style follow the following steps:

1. Open the document from which you want to delete the style.

2. From the ‘Home Page’ tab and from the ‘Styles’ group, click on the style
you would like to delete with the mouse right button and choose ‘Remove
from the style Gallery’ as figure (9 -26)

AaBbCcD: AaBbCcl AaBbceDe  AaBbCc Aasbcel AQ B assbeco
T Normal Subtitle T No Spac... | Heading 1 | Heading 2 Title Subtle Em...

AaBbCcD¢ AaBbCcD: AaBbCeDc AaBbCcDt¢ AaBbCcD:e AABBCCDC AABBCCDLC

Emphasis  IntenseE... Strong Quote Intense Q... Subtle Ref... IntenseR...

AaBbCcD«
Book Title

AaBk = ~ ) .
Update List Paragraph to Match Selection
T List
4 Modify...

=4

A4 Create a Style
Figure 9-26: A® Clear Formatti
Removing | ., Rename...

=4 Apply Styles..
aSter * SERYSY Remove from Style Gallery

Select All: (No Data)

Add Gallery to Quick Access Toolbar

9- 6 Document Management:

Word 2016 has some options that affect when applied to the entire page,
including page direction and size, page margins, and other options.

9- 6 -1 Page Setup:

Skill© - 24
Page Setup

To setup the page Follow the following steps:
1. Open the document you want to set up.

2. From the <Layout> tab and from the «Page Setting> tab click on one of the
page setting options (adjust the margins, change direction, choose page
size, add and remove columns, insert page breaks, show line numbers,
change hyphen) as in figure (9- 27)

3. Click the <Save» button for the document to save the previous settings.
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9 -6- 2 Insert Header and Footer:

Skill © - 25
Insert Header and Footer

i

The header and footer of the page are the upper and lower parts of the margins
of each page in the document where the data you want is written automatically at
the top or bottom of the page in all pages of the document.

To insert the header, footer, and page number follow the following steps:

1. Open the document on which you would like to insert a header and footer
to the page.
2. From the ‘Insert’ tab go to ‘Header or footer’ as form (9- 28)

Figure 9-28:

Insert Page

Header and
Footer

3. Click on the header and the header dialog will appear as in figure (9- 29)

[ ] Meader ~ A | B Quick Parts = ¥ Signature Line ~ 7T I
Built-in -

o bond

Austin

Banded

" lgy Dore Headers from Office.com

Figure 9-29:

Insert Page
Header [ Bemove Header
Window Lt

9 Ldit HMeader

4. Choose from the header dialog box the appropriate type of page header
that you want to add.
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It will be automatically inserted into the document

5.

6. The same steps can be followed to insert the page footer by clicking on the
‘footer’” option for the document as in figure (9- 30)

3 MHeader = (,\ I B Quick Parts = [ 2 Signature Line = 7T &
1 Foater = . A WordAn - 3, Date & Time QS
Builtin =]
Hiank
1hawe Sy
Blank (Three Columns)
VP - - — A ey
Austin
Nanded
[ nore footers from Office,cam
D) Ldn Focter
3¢ Bemove footes
“

9 -6- 3 Edit the Header and Footer:

Skill© - 26

€dit the Header and Footer

—
-~

To edit the header or footer of the page, follow the following steps:
Double-click inside the <header/footer» area.

The «design> will appear from which to go to the <header and footer» set to
edit the header and footer, for example if we want to change the date we
will click on it and make the necessary adjustments See Figure (9 -31)

1.
2.

j

3. Close this tab or double-click anywhere in the main part of the document.
4. Back to the normal editing view.
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9 -6- 4 Inserts Pages Numbers:

Skill S - 27
Inserts Pages Numbers

Page numbers are treated as a header and footer to the page because they

are at the top of the page or at the bottom. Page numbers are formatted like any
other text.

To insert page numbers follow the following steps:

1. From the <nsert> tab and from the <header and footer> group click on the
add page numbers

2. Options will appear to insert the number at the front of the page or at the
bottom of the page as in figure (9 -32)

3. Choose one of the appropriate formats to insert the page numbers of your
document

4. Click on the page number command that will cause the numbering to
appear on the page

8 i + S
il Store W E:é o Hyperlink [ Header =K
L . [» Bookmark [2) Footer~ 4\
& My Add-ins ~ Wikipedia ~Online Comment Lot

Video “J] Cross-reference <] Page Number~  po, -~ “ !

Simple 4[] Top of Page »
Plain Number 1 [ Bottom of Page ’

[#) Page Margins M
[/ Current Position M
F@ Format Page Numbers...
Plain Number 2 B( Remove Page Numbers

]
+ [ Select a Position that Shows the
Pages Number
|

Plain Number 3
< @

Select Number in
the Top of the Page

Page X
Accent Bar 1
1|Page
Figure 9-32:
Insert v
Pages [@ More Page Numbers from Office.com »

Number Eh Save Selection as Page Number (Top)
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9- 6- 5 Delete Page Number:

Skill© - 28
Delete Page Number

To delete page numbers, follow the following steps:

1. Fromthe <Insert> tab and from the <header and footer> group click on the
page number arrow

2. Options will appear, Click option on the <Delete Page Numbers> as in figure
(9-33)

[#] Page Number ~
[® Top of Page
Q Bottom of Page
[2) PageMargins
Figure 9-33: | [f] CurrentPosition

RemOVing [ff2  Format Page Numbers...
Page Numbers B

v v - -

Remove Page Numbers

96-6- Add and Delete a Cover Page:

Skill 9 - 29
Add and Delete a Cover Page

To add a cover page, follow the following steps:
1. From the ‘Insert’ tab and from the group ‘pages, choose ‘cover page’

2. Click on the cover page you want and this page will be included and you will
be able to edit the typical text in your text.

3. To delete the cover page click ‘Delete the cover page’ see Figure (9 -34)

Introduction to Computer Skills 275 -




Introduction to
.............................................. Computer Skills

Bj Cover Page ~ |
L] Blank Page

= Page Break

( Click on the Cover Page )

Pages
Built-in

Select Cover -
Page

Wt U]
——
———crmmm———=m

Austin Banded Facet

FDOCUMENT TITLE]

Remove the ——
Cover Page

="

Filigree Grid Integral

=5 More Cover Pages from Office.com 12
> Remove Current Cover Page
‘i Save Selection to Cover Page Gallery...

9 -7 Insert Images, Drawings, Tables, Shapes, Symbols and Equations:
9.7.1 Insert and Format Images:

e/nsert an Image:

Skill© - 30
Insert an Image

i

To insert a picture follow the following steps:

1. From the ‘Insert’ tab and from the ‘lllustrations’ collection click on the
‘Photos’ icon as in figure (935-)

-
1) ) SmartAn
. . Sore

e w Oni

.M Addins = Aipea nlme
v e doreimbet - 4 Video
Pagny Tabiey Hustrations Adg-m Media

Comments Heager & Footer

2. The ‘Insert Image” window will appear
3. Select the track of the image on the computer

4. Choose the image you would like to insert by clicking on it with the left
mouse button once
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5. Click on insert or click on the left mouse button double click in a row, the
image will be inserted into the document see Figure (9- 36)

n_ Incert Picture x
T “ Pictures + Saved Pictures v o Search Saved Picture
Orgenize ~ New folder = . m™ 0
Dozuments
Pictistes
B8 Thic PC | s
& 3D Objects ﬂ‘ >
B Decktop ' 2 3 ]

5| Docurnents
& Downlcads

- Videos 5 6 nddex

‘e Local Disk (C:) A

- D(E) Select Image ) 1

N 1
o (oo )@
Figure 9-36: Fite narme: [] w| Al Picges v
InsertImage
Window Toalk - Cancel

* Image Resize:

Skill © - 31
Image Resize

To resize the image follow the following steps:

1. Select the image to be resized by clicking on it with the left mouse button

2. Circles will appear on the borders of the image

3. Drag these circles out with the mouse to enlarge or to minimize the size of
the image see figure (9- 37)

N

Figure 9-37:

Changing u.l.lLlJ den IJ

Image Size

UNIVERSITY Of BISHA
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¢ Image Format:

Skill 9 - 32
Image Format

To format the image follow the following steps:

1. Select the image to change its format by clicking on it with the left mouse
button

2. Anew tab will appear under the name ‘Format’

3. Choose the appropriate tools to format the image see figure (938-)

(Z Pictime Border « - = Eany Forwaed
QO Pictune Effecty ~ Sendd lackwarc
Postsan Wisp

Setection Vane

N, Pictuse Layout

Text - N

Arvenge

A oe |
Figure 9-38: UNIVERSITY Of BISHA
Image
Formatting

The commands in the format tab allow:

Remove the background: to control the parts of the image
Corrections: to improve image brightness and contrast
Colour: to change colour

Artistic Effects: To add effects on the image

Image compression: to reduce image size

Changing the image: change to another image

Reset image: to ignore all formatting changes

N U A WD =
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Figure 9-38: UNIVERSITY Of BISHA
Image

Formatting

¢ Insert Pictures from the Internet:

Skill 9 - 33
Insert Pictures from the Internet

To insert a picture from the Internet follow the following steps:
1. Place the mouse indicator where you want to insert the image
2. From the ‘Insert’ tab and from the group ‘lllustrations’, click the left mouse

button on the icon ‘Online Photos’ as in figure (939-), and an Internet
connection must be available.

Figure 9-39:
Insert a".“\" Page* — [ ,i’»‘f-\‘*‘, -‘lm W ==_ E!Lmtm " Header~
Pictures from T o i o PO D

the Internet ' , o Lo g vameniis i Video ' 2, Fage Numbe

3. The ‘Picture Insert’ screen will appear, type the name of the image or clip
what you want to search for

4. Search results will appear from them choose the desired image and then
click on the ‘Insert” button and the image will appear where it was pre-set
instep 1
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9 -7 -2 Insert and Delete Shapes:

Skill S - 34
Insert Shapes

i

To insert and delete shapes follow the following steps:

1. From the ‘Insert’ tab click the left mouse button on ‘shapes’ as in figure
(9- 40)

L)
Shapes

Recently Used Shapes [«]
BENNOOCOALL2LG
CIRYAUR SIS I A {

Lines
NNNTLLTLQNG%
Rectangles
OoOoaobOooo

Basic Shapes
EOAMNITASOOOO®
eGOo0OrLy xOB8a
O0@®AOQVOXEG CBN
OO0 ) €3

Block Arrows

DL RTHPLEPR IS
€ VD >N
GOR

Equation Shapes

FPERESHA

Flowchart
O0C<coooUsooayY
CUAdAKRB X ¢ AVAD
Qe 0o

Stars and Banners

TEEP A DG @
£k TF ik X [T L0

Callouts L]

DO QB0 @A AL g A3 Al

E") New Drawing Canvas

2. Select the required shape from the set of shapes by clicking on it with the
left mouse button

3. Select what you want to insert the shape and then continuously click the
left mouse button to start the insertion process with the indicator pulled in
the desired direction as in figure (9- 41)

4. Control the shape resize in the same way you used to change the size of the
image above.
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iy aenls

UNIVERSITY Of BISHA

Figure 9-41:
Changing
Shape Size

e Format Shapes:

Skill S - 35
Format Shapes

i

To format shapes, follow the following steps:
1. Select the shape to be formatted by clicking on the left mouse button

2. Anew tab will appear as ‘Format’ click on it and then select the appropriate
tools to format the shape such as:

e Shape style

e Fill the shape

e Qutline of the shape
e Effects of shapes

3. To add text inside the shape click the right mouse button on the shape

and then click’Edit the dots’ to add text or to edit text points click see
Figure (9-42)
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3 Cut
E® Copy
y Paste Options:

AN

0

(Add Text Inside The Shape) ‘ AGd Text |
( Edit the Points of Shape )‘ 4—!—‘- %d't Points ]
I Ircoup

( Shape Format Tools ) ™, Bring to Front >
r o Send to Back 3
% Hyperlink...
Insert Caption...
=~ Wrap Text >

Set as Default Shape
Moere Layout Options...

W

Format Shape...

|
o Z

Style Fill Outline

¢ Insert Video from Internet:

Skill © - 36
Insert Vedio from Internet

To insert a video from the Internet follow the following steps:
1. Place the mouse indicator where you want to insert the video

2. Fromthe ‘Insert’ click on the ‘Online Video’ icon

3. The video insert window will appear, write the name of the video you are
looking for and you want to upload it within the document, for example
we would like to search for a video in the name of the prophet’s biography
from YouTube

4. Search results will show the desired video and click on the ‘Insert” button
see Figure (9 -43)
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9 -7 -3 Insert and Use Word Art and Smart Art:
¢ Insert Word Art:
Skill ©9 - 37
Insert Word Art
=

Uses Word Art to add document-specific text effects

To insert a Word Art font, follow the following steps:

1. Place the mouse pointer on the text you want to add the Word Art effect.
2. From the ‘Insert’ tab click left mouse button on Word Art

3. Word Art options appear as in figure (9- 44)

ai

A

2D

{

€3

2

Bl
I

o O l
» P B

K

D> D
P>yt

QOutline
Shadow

Reflection

o PP

Glow

-

N

w

Number Styles

YyYyvyvyvyy

Ligatures

b

Stylistic Sets

4. Choose the effects of Word Art and the effect will appear on the text see
Figure (9 -45)
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Universiy of Bisha
Paenly of Conpaters & Indormmstion Techmology

5. Word Art style can be chosen first and then we write the text and the Word
Art effect will appear on the entered text

e [nsert Smart Art:

Skill© - 38
Insert Smart Art

To insert the Smart Art chart, follow the following steps:
1. Place the mouse indicator on the text you want to add the Smart Art effect

2. From the ‘Insert’ tab, click the left mouse button on ‘SmartArt’
3. Smart Art Graphic Options screen will appear
4

. 4. Choose the Smart Art drawing that isappropriate for you and then click
‘OK’ see Figure (946-)

Choose a SmartArt Graphic ? X
List > ;
= ]
= ls = l;% .5 S -
== GO e =
w0 Process = (&3] =) -
o N N AT
W Gy _ = 0
S o —_ = =
=, 2
E Re2ationsh
Matie a0 - - et ¢ :ﬁ' ‘?:1 -
¢ = e == Hil
/_\ Pyrarmid — o
Basic Hiock | st
el Prcture ‘\’E_JJZ‘ GG o-s-0- 4¢-@- Ute 10 thaw nanA#qUeNtIAl Of grouped
@ Officeco [ E‘ =l ——— I :' | nlarks of mnfoemation, Mamires Doth
= honzontal and vertical display space tor
thapes
]
v
i
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9- 7 -4 Inserts a Chart:

Skill © - 39
Insert a Chart

i

Word 2016 adopts new types of charts that help display data in ways that
the user can understand and compare, the most important of which are (vertical,
tape, linear, circular)

To insert a chart follow the following steps:

1. Place the mouse indicator in the text that you want to insert a chart on it

2. From the ‘Insert’ tab and from the ‘Illlustrations’ collection, choose a ‘chart’

icon

The dialogue box will appear (insert ‘chart’)

4. Click with the left mouse button in the shape of the chart you want to
insert and then click on ‘OK’ see Figure (9- 47)

w

Insert Chart ? X
All Charts
™ Recent
wee ([0 A0 AR 5 08 09 H9
Column
oy Clustered Column
pie Chan Tie
’ Vertical Chart
Bar ‘
Are
XY [Scatter) )
I Chart Preview
Stodk I Al pre— e e

Histpgram :
. ( Select Vertical Chart )
Box & Whisker

Waterfall

Combo 4—‘ ( Options of All Charts )

i

EEEFOHEXBEMREEM e RHE

IL_ox | conce |
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9 -7- 5 Insert and FormatTables:
9.7.5.1Tablelnsertion:

Skill © - 40
Table Insertion

Tables are a good way to organize information with documents, and Word2016
allows you to add a table within the document and format it as necessary.To insert
a table within the document follow the following steps:

1. Place the mouse indicator where you want to insert a table
2. From the <nsert> tab click the table option, drag the table dimensions on
the grid and click the left mouse buttonsee figure (948-)

.E:-Mnr' = I T areve e ek 2 Hesde v B Qudow
{ 0O s [ WV La
el 00 A ] (e R g ™ o bawler + A Redie
Fetiom Oriew Supm Wy At + Mpecie  Ordee Comrwt -t
Ehgpe b . [ 5o Do Strseghat+ By e Vidw O rfere o Pgelamtes g ' omiy
regr ) Lkl un el Lt et e e

Figure 9-48:
Insert Table

3. Or atable can be also inserted in a ‘table insert” way
4. The ‘Insert Table’ dialog will appear and select the required columns and
rows in the table see Figure 9- 49.

?
1 < Insert Table ? x
( Select Number of Table size
Columns [ =
Number of columns: 5 =
Number of rows: 2 =1
5 |
AutoFit behavior
( Select Number of @) Fixed column width: |Auto =
Rows ; o
(O AutoFit to contents
Figure 9-49: (O AutoFit to window
Insert Table by
Se|ecting the [[] Remember dimensions for new tables
T R
and Columns »
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5. Click on the ‘OK’ button, the table will appear in the document as the figure
(9- 50)

Figure 9-50:
Table
Inserted

e 92.5.7- Table Format:

Skill © - 41
Table Format

You must select the cells you want to format, and to select table cells, follow
the following steps:

1. Place the mouse indicator over any part of the table and click the four-
headed arrow icon over the upper corner of the table as in figure (9- 51)

Figure 9-51:
Table o
Prosperities
using the
Headed
Arrow

2. From the ‘Home page’ tab choose font type, size, colour, cell fill colour, text
alignment (right, left, centre)

3. Control the height of the rows and the width of the columns by pulling the
mouse button.

4. The previously selected format will be applied to the schedule.

93-5-7-Use Automatic Formattingfor the Table:
To use the automatic formatting to the table, follow the following steps:

1. 1. Select the table in the box by clicking on the four-headed arrow icon
above the upper corner from the right of the table
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2. from the <Design» tab go to the <Normal Table> option and the format
window appears as figure (952-) and from which to choose the appropriate
format.

Figure 9-52:
Table Format

3. Once you have chosen a format you will notice it applied to the table

9 -7 -5- 4InsertsRows and Colum in the Table:

Skill© -42
Inserts Rows and Colum in the Table

To insert rows and Column to the table, follow the following steps:
1. Select the row you want to insert above, bottom, right, or left of it

2. Place the writing indicator in any cell of the row

3. Go to the ‘Layout’ tab and from the ‘Rows and Columns’ group click the
icon ‘Insert” with insert options (up to the bottom right left) as in figure
(9- 53)
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Y

i
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BorderStyles ~ » | B Insert Rows Below
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% Hyperlink...

t;] New Comment
|
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e 9-7-5-5Add Borders and Shading to the Table:

Skill 9 -43
Add Borders and Shading to the Table

L 4
To add borders and shading to the table, follow the following steps:
1. Place the mouse pointer in any of the table cells
2. From «Design» select Page borders tab
3. The «Borders and Shading» window will show which choose <borders’
4

. Choose the border shape of border options from the right of the border
window and shading (without, surround, all, grid, custom)

5. Choose the style or shape of the border from the centre of the border
window and shading

6. Choose the colour of the border from the centre of the border window and
shading
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7. Choose the width of the border from the centre of the border window and
shading and you will notice the preview to the left of the border window
and shading see figure (9- 54)

1 ( Borders Options 2 Borders Style 4
!

Borders and Shading ? x
Y
§orders| Page Border Shadin \
Setting: Style: Preview
e ~ Click on diagram below or
None use buttons to apply borders

Grid

Custom 3pt

:nlu [ 7] [ 1] ] m i
Ul R N R | it
12>

<

Apply to:

Figure 9-54: T Table ~]
3

Insert

Borders Borders Color ) I_ | '
Window = —_—

8. Click ‘OK’ at the bottom of the border and shading window and the table
will appear with the borders and specifications chosen see Figure (9- 55)

Figure 9-55:
Table
Borders after
Applying
Selected
Formats

9-7 -5- 6 Add Shading to the Table:

To add shading to the table follow the following steps:

1. Click on the «<Shading> tab from the border window and shading

2. Choose the shade colour you want

3. Choose the shade style from the bottom of the border window and shading.
4. Click OK at the bottom of the border window and shading see figure (956-)
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Borders and Shading
'§orders Page Border
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Patterns | A\
Style: D Clear e
Color: Automatic v
Apply to:
Table
[ ok ]| canca |

5. The table will appear directly in selected formats as in figure (9 -57)

9 -7- 6 Inserting Symbols and Equations:

Word 2016 allows you to insert mathematical symbols in the form of equations
or texts using equation tools

9- 7- 9- 1 InsertsEquation:

Skill S - 44
Inserts €quation

To insert an equation, follow the following steps:
1. Place the indicator where you want to insert the equation

2. From the Insert tab and from the ‘symbols’ group click the arrow in the
equation,

3. Click ‘Insert a new equation’ see Figure (958-)
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[ Quick Parts ~ [Z’SignatureLine - | TC Equation ~

Built-In ‘
‘ Area of Circle
Equation A=mr?
Button

[»]

Binomial Theorem

n

(x+a)"= Z (:)x"a""‘

k=0

|Expansion of a Sum

nx n(n—-1)x2
(1+x)"=1+—+¥

1! 2!
Insert a New
Equation Fourier Series
nmx . nmx
fx) =ap+ Z (ancosT +b, smT)
n=1
@ More Eqvtions from Office.com 4

T Insert New Equation
[#] Ink Equation
B Save Selection to Equation Galle

9-7-6 -2 Insert Symbol:

Skill © - 45
Insert Symbol

To insert a symbol, follow the following steps:

1. Place the cursor where you want to insert the symbol
2. Inthe ‘Insert’ tab click on ‘symbol’as in figure (959-)
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3. Click ‘More symbols’ to show the rest of the symbols when you find the
symbol you want, click on ‘Insert” or double-click the left mouse button
above it and it will be inserted directly into the documentSee Figure (9- 60)

Symbol ?' Select Symbols ' ? X
Symbols  Special Character.

Font:|(normal text Subset:| Currency Symbols N
Bi«l7ols]p|e|ale]¢][z]e]e]n]e]e]
BIO|%]| & |Ne|® | |™|Qle|d|%|1|%|%]|%|%

%% | %|%| %|%|%|%| V|2 |||V I T

RIAIN(Z Lo [A|TTIS|-|/] - |V]e=|L|n]] |
Recently used symbols:

€L ¥|O|® ™ z|£[<|2]+|X|eo|u|a|B|m

Unicode name:
Euro Sign

Character code: | 20AC | from: Unicode (hex) .

| AutoCorrect... | | ShortcutKey... | Shortcut key: Alt+Ctrl+E

Insert

‘ Cancel ‘
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Microsoft PowerPoint

@P Main objectives:

1. The ability to create and edit slides.
2. The ability to insert and modify simple and large graphics.
3. Add sounds and animations to the slides.

@) Secondary objectives

After studying this chapter, the student is expected to master the following
knowledge and skills:

Master the running and closing of PowerPoint program.
Learn how to open and close a presentation

Adds and deletes a slide.

Learn about changing slides within presentations.

Learn to add objects on a slide.

Learn to add and edit slides wallpapers.

Arrange and edit slides.

Learn to draw and insert shapes and graphs on slides.
Learn to add photos, sounds, and video to the slide.

‘O 0o SEOECIRE I
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10 -1 Introduction

In this chapter, we will review number of skills that student can be able to
learn by using Microsoft PowerPoint 2016 or what is known as the PowerPoint

Program. All these skills are only related to Microsoft PowerPoint 2016 so that we
avoid repetition:

e What is Microsoft PowerPoint?

e New features in the PowerPoint program.

e The ability to deal with the interface of the power point program through
which you can create, open, or close the program.

e Dealing with the power point program using slides or layout.

* How to create a presentation and the ability to add, edit or delete slides.

e Use parts that enable us to insert content into slides.

e Changing slidesof the presentation.

e Choose and reset the layout of the slide.

e The ability to open, close and save files.

e The ability to obtain commands in the program of presentations through
the command and instructions screen.

10- 2 Features included in the new version of Office 2016

e The new version provides us with the ability to share in writing and edit
the file at the same time, which is one of the advantages of working on the
same file at the same time with colleagues, so colleagues can edit the same
file if it is saved in SharePoint at the same time, which is advantage enables
group writing and the ability to participate in document output.

e The ability to send files of large sizes using cloud storage (OneDrive), which
is an important feature that enables the user to save huge files in the
cloud storage service by sending Url of the file using (Outlook) as well as
modifying the files inside the storage location.

e Recovering files that were indeliberately deleted, and this file is saved in
SharePoint or OneDrive Here deleted files can be recovered by going back
to previous versions of Office.

e The smart search and replace feature, which is one of the most wonderful
features of Office 2016. Through this feature, a specific word can be located
inside the document by right-click to search for the word through the Bing
search engine. This feature is useful in facilitating the editing and addition
process as it also helps to replace written words with another.
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e We find that there is the Groups feature in Outlook and it is a new feature
that was added in the new version of Office. Now it is possible to create
new lists include friends and colleagues with customizingfor each group an
incoming and sent email as well as calendar and OneNote.

e A new set of graphs, longitudinal and horizontal squares has been added
in the new version, which is more flexible and sophisticated than previous
versions that were difficult to use.

e The possibility of predicting the probable results and this feature is called
a predictive text, which is a possibility was included in the charts in
Excel, characterized by the speed of predicting the results and extracting
the predictions by just pressing the mouse button, and it was designed
specifically for employers to give reliable calculated results.

e Using Skype, which is an important feature for businessmen, as it enables
them to use Skype within Word or Excel, now, video calls or messages can
be answered without leaving the document that is being worked on.

 Finally, Office 2016 is interconnected with all systems. |t is compatible with
the Windows and Mac operating systems as well as with Android and OS.

10- 3 PowerPoint Program

The powerpoint Program or what is known as the Microsoft Power Point is
considered one of the programs available at Microsoft Office and Power Point is
specialized in creating presentations, as it provides many features that make the
process of creating and presenting presentations easy.Microsoft PowerPoint 2016
is the version number fifteen for Microsoft. |t is considered one of the effective
programs in presentations (interactive presentations), whereby it is possible to
create slides that appear sequentially, automatically, or interactively, with the
addition of animations and sound effects accompanying the animation. The power
point program enables its user to:

e Share files with others.

e Store filewith PowerPoint format that is modifiable, or an automatic
presentation that can be played without a PowerPoint program on the
computer or in form of video.

e easy handling of charts and faster.

10 -3- 1 Fundamentals of design using PowerPoint
PowerPoint depends in its use on the fundamentals of which you must:

e The user should focus on coordination with the required form.
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e The user should focus on using small sentences.

e The subtitles are distinguished by different colors and fonts, focusing on not
using multiple fonts in one display, and focusing on using colors according
to the degree of event and excitement.

10 -3- 2 Open and Close Power Point Program 2016

Skill10 -1
Open and Close Power Point Program 2016

To open and operate the PowerPoint program, there are several methods
that can be used, such as:

1. From the Start menuin Windows 10, click the left mouse buttonon the
Windows icon, as shown in Figure 10 -1.

e Then move to all programs.
e Then enter the application programs and search for the PowerPoint
2016 program

2. Or directly, type in the search box as in Figure 101- Microsoft PowerPoint
and then click the mouse button to open the PowerPoint program.

C tay and oxplon

@ © =

Groove Music Movies & TV

Figure 10-1: %

To Open and §
Run
PowerPoint &l
Program

St ) @ Csemen)
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3. Or from the desktop, by pressing the right mouse button on a place free of
the desktop, then selecting New, then Microsoft PowerPoint presentation.

After entering Microsoft PowerPoint, the main options window will appear, as
in Figure 10 -2, where we can:

* Create a blank presentation.
e Or use an existing presentation.
* Or use a ready-made presentation as a template.

PowerPoint i

Close Button

Recent

Figure10-2:
Creating a
Blank
Presentation

e To close the PowerPoint program, click the left mouse button on the "X"
icon located at the top left of the open window, which closes the file or by
using the close buttonin keyboard (Alt + f4).

10- 4 Interacting with PowerPoint using templates

Skill10 -2
Creat New Template or Using €xisting Template

i

We mean with templates in the powerpoint program, files that have already
been prepared, and on using this template the program will make a copy. In caseof
the need to save this template, it will request a new name for the file to save
it with this name without causing a change in the main name. There are many
templates in the PowerPoint program, and some templates can be downloaded
from the Internet. You can also create new templates of your own and with all
the formats you want to use it later without having to do formatting again. To be
able to create a new template or an existing template, you must use an existing
template or file by following these steps:
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e From the main options screen of the PowerPoint program, we choose one
of the existing templates, or we write the name of the template in a search
boxabout the related templates and themes at the top of the screen,
according to the arrow indicated as in Figure 10 -3.

Search for Online Template

CZXBIank Presentation)

PowerPoint L

Recent

[T w Fwpa

Aa Aa Aa

3 ¥ HEE =

mbsb= i

2 2 A |
EEEEe “-l

Thg

Aa

Figure10-3:
Creating a
New
Template or
Using
EXIStlng B (o Cifer Fresentalion:
Template

1. Search box of Templates: Helps in searching for existing ready-made

templates. Or if you know the name of the template and it does not appear
in the available templates on the screen, you can type the name and then

press the enter key.

2. Blank presentation: This means that it will open a blank slide without
formats and the user can perform the format that he wants to add.

3. Ready Presentation: It allows to use one of the ready presentations
available within the PowerPoint program.

4. Login: if you have a Microsoft account to see what is new.

* Once you click on any of the mentioned templates, a set of pre-prepared
templates will be shown, and you can choose any of them as needed.

Selecting the template is done by clicking on it with the left mouse button

once. A window will appear containing information about the selected template.
We can also move from one template to another through the templates in front

of you. Once you choose one of the templates, you will see several options for the
template itself and we choose what we want by clicking Create as in Figure 10 -4.

- 302 Introduction to Computer Skills




® Practzcal Part ® Part Chapter
Microsoft PowerPoint

.

Title Layout

Figure10-4:
Selected
Template

4 Mozimages b
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Option (1) allows us to create a template from pre-existing templates by
clicking on the “Create” option. By clicking on it, the main window of the program
will appear to us.

How to save the presentation

To save a PowerPoint file, there are several ways in which the file can be
saved and they are:

A- Go to:
¢ File menu in the main window

e Choosing the "Save" or "Save As" command, sometimes we find a
difference between the two options. The "Save" option is used when
saving a new file for the first time or anupdated file. Either the "Save as"
option is used in the case of saving the file for the first time, or in the
case of a file that has a previous name and we want to keep another
copy with a different name.

B- You can press Ctrl + S on the keyboard at the same time.

C- The power point program also allows us to save to old versions, or directly
as a PDF file.
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10 -5 The main Interface (Window) of the User

Skill10 -3
Dealing with The Main Window (Interface) of the
Microsoft PowerfPoint Program

When you choose the option “blank presentation” in Microsoft PowerPoint
2016, the main user interface for this program appears, as shown in Figure 10 -5,
which contains several tabs.

2 | File Tab Ribbon Tab

0 Quick Access Toolbar Tab) 0 Commands Tab )

Toolbar Tab

[ New Slide Tab J

Figure10-5:
Microsoft
PowerPoint
2016 Home
Page

e Wleewn B B W l?_l 1

D oA

1. Quick Access Toolbar tab: The quick access toolbar can appear above or
below the Ribbon. To change its location, click the drop-down arrow to the
right of the toolbar and click Show below the Ribbon. Through the quick
access tools, the user can open a new document, save, or print a file, and
there are also other options inside it.

2. File tab: enables the user to open a new page, print, save a file, or open an
existing file inside the computer or one of the storage media.

3. Ribbon Tabs: By default, in Microsoft Office PowerPoint 2016 there are
more than ten tabs (except for the File menu). Sometimes you will see
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coordination tabs that show if you are working with a special type of object.
For example, if you are working on a photo.

4. CommandsTab: Each tab consists of groups of commands. For example,
the Home Tab has clipboard commands, slides, font, paragraph, drawing,
and editing.

5. Toolbar Tab: Contains numbers of options that enable you to search or
replace, select, edit, and more.

6. Slid ShowTab: It is the button through which the user can start the show
once it is finished or by using the option (F5).

7. Work area: The area through which the user can write or edit any text,
photos, or table according to what he needs.

8. New Slide Tab: allows us to add any number of slides under the master
slide.

10- 6 Home page Tab in Microsoft PowerPoint 2016

Skill10-4
Working with the Home Page Tab

i

The home page consists of several groups, as in Figure106-, and they are:

Clipboard group.
Slides group.

Font group.
Paragraph group.
Drawing group
Finally, editing group

SEAEE I N
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Click to add title
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Figure10-6:
PowerPoint
Home Page
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1. Clipboard group: This group contains several options that can be used
continuously within the PowerPoint program, such as an option:

Paste ( "79).
Cut text ( ).
Copy text ( ).

Use the format painter ( ) to copy the formats of selected text to apply
it to the rest of the text.

You can also click on the small arrow below the group to add other options
(= ) - Toimplement any of the options, we follow the following steps:

. -

Select the text or shape you want to copy or cut.

Then we press the Cut option (to cut the original shape or text) or the Copy
option (to make a copywith the original copy).

Then we press Paste (to place it where we want to place it)
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Table 10 -1 shows the option type, icon, and abbreviation for easier handling.

Table 10 -1: Shows icons with their abbreviation in the clipboard group

Option Name Icon Abbreviation
alln
Paste D Ctrl+V
Cut Ctrl + X
Copy Ctrl+C
Format Painter Ctrl +Shift+ C
Other @ -

2. Slids Group: This group contains several things that are of great importance
for the PowerPoint program, including:

e Addanewslide (- ).
e |t can also show more slide themes ( s:a\';:v)

e You can make a slide layout or choose another type of slide layout

( [Z]Layout~ )
* Reset all slide elements to their original position ( ] Reset ).
e Add a section to the slide ( {7 Section ~ ).
Table 102- shows the option type and icons for easier handling.

Table 10 -2: Shows the icons in the slide group

Option Name Icon Abbreviation
New Slide |__\ Ctrl + N
Slide Theme e -
Slide Layout [-] Layout ~ -
Rest the slide to its original form ] Reset
Slide Section 5 Section ~ -
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3. Font group: This group is considered one of the groups used by which many
formats can be made to the text such as changing the type of font (/= </ortant o)
or font size ( ). Also, the font for the text can be made bold ( © ), italic (¥ ),

or the text contains a linebelow it ( “ ). It is also possible to make a shadow for

the text ( $ ). Also, in the case of using the English language, the letters can be
changed from small to capital or vice versa by option ( ~#= ) and in many cases
we need to change the color of the text ( ~ < ) and you can also enlarge and
reduce the font size by option ( ~ “ ) and many other options. To apply any of the
options, we follow the following steps:

A- First method:

e Select the text to which the option is to be applied.
e Directly choose the format to be applied from the font family within the
home page tab.

B- The second Method, which is by clicking on the right mouse button after
selecting the text and choosing the Font option that shows the interface in which
the option can be applied.

Table 10 -3 shows the type of option and the icons for easier handling.

Table 103-: Shows the icons in the font family

Option Name Icon Abbreviation

Changing the type of font - Calibri Light (¢ -
Font size - -

Bold font - Ctrl+B

Italic font I Ctrl + |

Underline the text u Ctrl+ U
Shading the text S -
Changing the letters from small to - Aa )

capital

Changing text color - -
Increasing or decreasing font size A A -

4. Paragraph group: It is considered one of the most used groups in all
Microsoft Office programs. For example, it is possible to center the text (= ) or
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make it to the right ( = ) or left ( = ) or adjust the text (- =). Also, it is possible
to make a bulleted list ( =% ) or numbered list (- =%). We also find there are many
other options that can be used by paragraphgroup. To apply any of the options,

we follow the following steps:
A- First method:
e Select the text to which the option is to be applied.
e choose the option to apply to the selected text.

B- Or, by clicking on the right mouse button, a tab appears, from which we
choose the “Paragraph” option, which shows a window through which the option
we want can be applied.

The following Table 10 -4 shows the option type, icons, and abbreviation for
easier handling.

Table 10- 4: Shows icons in a paragraph group

Option Name Icon Abbreviation
Centering the text = Ctrl+ E
Align the text to the right = Ctrl +R
Align the text to the left = Ctrl+L
Adjust the text H= -
Making bullted list = -
Making numbered list = -

5. Drawing group: This group allows us to add shapes and drawings within the
PowerPoint slide, for example, we can add and choose any shape that we want to
use by clicking on the Shapes ( ..~ ) option that shows you many shapes, one of
which can be chosen. To add any shape, we use the following steps:

e From the "Home Page" tab, we select "Shapes" that are located within the
drawing group, and a menu appears as in Figure10 -7.

e We choose the shape that we want toinsert by clicking on it with the left
mouse button.

e Go to the place we want to place the shape in and press the left mouse
button to apply.
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The objects on the slide can be changed and arranged through the option
(-2). Tochange the order of a specific object inside the slide, we use the following
steps:

e From the "Home Page" tab, we choose "Arrange" which is located within
the drawing group, so a menu appears as in Figure10- 8.

* We choose the option that we want to apply to a specific object in the slide
by clicking on it with the left mouse button.
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We can add different styles to the shape as desired by pressing option ( _ [a“/‘} )

. Various effects can be added to the shapes by clicking on the option ( *=- ) in
addition to coloring or filling the shape through the option ( == - ). The drawing
group contains other options that can be obtained by clicking on the arrow ( =)
at the end of the group as in the previous and subsequent groups. For example, to
fill a specific shape inside a slide, we use the following steps:

e From the "Home Page" tab, we choose "Shape Fill" that is located within
the drawing group, and a menu will appear to us, as in Figure10- 9.

* We choose the option that we want to apply to a specific shape in the slide
by clicking on it with the left mouse button.

Shape Fill )
hape Fill = A2 Find

Theme Colors
| HE NN Hu

Standard Colors

| P EEEERN
Mo Fill

% More Fill Colors...

Z¥ Eyedropper

Q Picture...

[ Gradient >

Texture >
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Table 5 -10 shows the type of option and icons to facilitate their handling.

Table 5 -10: Shows the icons in the drawing group

Option Name Icon

: %
Shape option S
[y
Arrange Objects in the slide . =0
rrange
Add Shape styles )
Add Shape effects B L
Add Color and fill < -
other r.

6. Editing group: This group enables us to have several options, for example:

e |f we are searching for a word inside the PowerPoint presentation, we can
use the option ( O Find ) or by pressing (Ctrl + F).

e Through this group we can replace a word inside text by option
(5 Replace ~ ) or by pressing (Ctrl + H).

e |tisalso possible through this group to select a specific text or all the text inside
the PowerPoint slide through the option ( [} Select v ) or press (Ctrl + A).

e We find the explanation above shows all the options within the home tab
we hope we have covered within this course. For example, to search or
replace a word within a slide we use the following steps:

e Fromthe "Home" tab, select "Replace", which is located within the "Editing"
group, and a menu appears for us, as shown in Figure10- 10.

e We choose the "Replace" option by clicking on it with the left mouse

button. A window appears to enter the word you wish to replace and the
replacedword.
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Replace )

Replace ? >

Find what: Find Mext

!
Replace with:
| Replace

[] mateh case

|:| Find whole words only
[] matech Diacritics

[ match Kashida

|:| Match Alef Hamza

Replace All

Table 10 -6 shows the option type and icons for easier handling.

Table 10- 6: Shows icons in an editing group

Option Name Icon Abbreviation
Search for a word L Find Ctrl +F
Replace a word . Replace v Ctrl + H
Selecting specific text or all the text I Select v Ctrl + A

10 -7 Insert Tab

Skill10 -5
Using the Groups included in The Insert Tab

i

The Insert tab consists of several groups (or orders) as in Figurel0- 11
which are:

e Slides.

e Tables.

e |mages.

e |llustrations

e links.

e Comments.

e |n addition to two sets of text and media.
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Also, some groups will have a small button in their lower left corner, clicking on
this button will open a list with more features associated with that group.

1. Slides Group: This group contains several options such as:
e Insertanew slide by pressing ( | | ).

e Choose a slide theme from the existing themes by clicking on the small
arrow in the right of the shape ( ,_) that gives you several options such as
title slide or title and content ... etc.

* |t contains several other options that user can use, such as choosing the
appropriate layout that you want to use to create the slide by clicking with
the mouse on the layout that you want to use.

e Another way to choose a specific layout is:

e C(licking the right mouse button in the existing slide will show you several
options, including the layout
e Click on the Layout option. Layout options appear as in Figure (10- 12).
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2- Table Group: This group considers its commands are important commands
that we use within the power point program and it has several methods:

e First method: Insert a table ( [4;‘;;} ) with a certain number of rows and
columns by dragging on the slide to create a table with a specific size, which
is as follows.

1. Place the mouse pointer where you want to insert a table.
2. On the “Insert” tab, click Table option, then drag the table dimensions
onto the grid, then click the left mouse button, see Figure 10 -13.

Insert Table )

Table Pictures Online Screensho
- Pictures -

1023 Table

B Insert Table...
[ Draw Table
EE] Excel Spreadsheet
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¢ The second method: Use the “Insert Table” command located within the
“Table Tab “, then specify the number of rows and columns and click “OK”
as in Figure 10- 14.

QXN umber of Colu mns)@xN umber of Rows)

Insert Table ? X

Figuret0-14: | Number of columps:] |5 -
Insert a
Table by the . -
Number of |Number of rows: | 2 =
Rows and
Columns K Cancel
( clickOk

w

. Images Group: This group is used to add pictures through several options:

Add photos from the internet directly by clicking on the option (.= ).
Add photos through an open window on the screen (.=:.).
Insert an image on the computer by pressing option ()

Patum

Insert an image from an existing or created photo album ( o ).

>
har =

And in each option, by simply clicking on it or the arrows next to it, you will see
several options that help you to accomplish the work and to insert an image exists
inside the computer, we follow the following steps:

e Determine where to insert the image by left-click.

e From the “Insert” tab, choose “Image” that is located within the “Images”
group as shown in Figure 10 -15.

e The Image window appears for us and we select the image we want to
insert and click on it with the left mouse button.

e Click on the “Insert” option to execute.
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4. lllustrations group: We find in the Power Point presentation program we
can include automatic shapes such as:

e Circle and rectangular shapes or arrows.
e Add flowcharts.

To add shapes inside the Slide of powerpoint program,go to:

e |nsert tab.

e Choose the Shapes ( - ....) option within the group for illustrations.
e |t displays several shapes.

e Through which the shape to be applied is chosen as in Figure1016-.

@ PE| I I a Stare

Shaped SmartArt Chart aMyAdd—ins -

Recently Used Shapes o
B~ ~wOoOoA L LG
% e Y ey

Lines

St S T TLL s NS R
Rectangles

(R I L A

Basic Shapes
ElOANOTOSOOO @@
@LOCOOr LE &80
OJO@~HEO X[ Caa™
[ T I S
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If you need to add SmartArt, we follow these steps:

e Fromthe"Insert"tab, choose"SmartArt", whichislocated withinillustrations
group, click on it with the left mouse button, and a list will appear, as shown
in Figure 10 -17.

e We go to drawing options to choose the desired drawing shape

e Then we choose the desired shape

e We click on the "OK" button to apply the required shape

Option SmartArt (Sub Shape Selection)
- =1 o =1 A MM = Lt -1
(|| [ EUE = %] | L = 4 B GE o) 7
proartArtl Chant g (1 g . Hyperlink Action | Comment Text  Header WordArt Date &  Slide  Object  Equa
i Bor & Footer Time MNumber

liustrations Add-ins Links Commen
Choose a SmartArt Graphic v
List -~
I Al
i L=t =3 I @ ] B —
= EC < & —_ =
% Process ; s & =EE
4# Cycle = )
B Hierarchy " ’ 1 [El=l=] o
i ] —
B Relationship ’ '
&5 Matrix 5[.355 o e-0
é Pyramid . -
5 ~ Basic Block List
Pi —=1=
cture ‘E]I = [__[—”_‘ Use to show non-sequential or grouped
= = il blocks of infarmation. Maximizes Both
=S horizontal and vertical display space Tor
£ e shapes
= =
= |
== v

|
& SmartArt Options ) Click Ok

The illustrations group also contains the chart option ( ® ¥ ), through which
you can show many shapes that can be inserted, which often help us to represent
the data and also can be used within the powerpoint program. When you click on
the chart option, the following screen appears for you as in the figure10 -18.

| Insert Chart I - -
i (me (HA s =® @m0

Clustered Colurmn

Cancel \

| cances

5. Links group: This group is considered one of the commands through which
it is possible to:
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e Connect the slide to internet.
e Orlink it with another slide.

The option hyperlink (=) links (text, images or anything) either to a web
page or an email or to other slides and when you click on it the screen will appear
as in Figure 10- 19.

Insert Hyperlink ? X
Link to: Text to display: luh I SaeenTip...
i) Lookin: 5] Siaig . : L
Existing File To Link Text with Existing File or Web Page
or Web Page Corent 3dsMax ad ‘ Bookmark...
urri
9 Folder ;d‘?be
asic . . .
Place in This v To Link Text Place in this Document )
Document Browsed )
Pages Custom Office Templates |
o Downl ) )
B £ To Link Text with Create New Document )
Create New Recent
Document Eiles EGDownloads ‘
Fax S
agddres—! ‘ To link Text with Email Address
E-mail
Address

There is also another option is the option action (i:_..'), through which a feature
can be added.When clicking on any object or moving with the mouse over it,you
will either be taken directly to the slide that you have selected to perform the

action or open a program. When you click on it with the mouse, the figure 1020-
appears to us.

Action Settings )

Action Settings ? >

Mouse Click plouse COver

Action on click

® None

O Hyperlink to:
[Mext slide

() Bun program:

| Browse...

Run macro:
| ~]
Object action:
| ~]
] play sound:
[(Mo sound) ~ |
Highlight click
| ok | | cancel |

Introduction to Computer Skills




Introduction to
.............................................. Computer Skills

There is also the option Comments in which you can insert a comment by
clicking on the option ( & ), and when you click on it the screen appears as in

Figure10- 21. comment
GXComments Option)
Comments 7 e
5 New AN A
Figure10-21:
Insert 4 ASUS A few seconds ago
Comments

4. Text group: This group is considered one of the most important groups
that are used continuously within any slide and through which many edits can be
made to the text or slide and the most important commands of this group appear
in Figure 10- 22. We will explain the contents of this group.

) @
D A4ABE

Figure10-22:| Text Header WordArt Date & Slide Object

Text Group Box & Footer b Time MNumber @ Slide Number
Text
Header & Footer) Date & Time )

From Figure 10- 22 we can make several commands such asadding a text box
through the option ( =

.-;;_-I ) and this is done by clicking on it and then we write
the required text inside the box that appeared to us.Also, wecan add a header

and footer for the page through the option ( ....L. ) which by clicking on it
and choosing it, the screen appears as in Figure 10- 23. The options inside the
header and footer allow us to add a time and date to the slide.lt also enables us
numbering the slide according to the available numbering, also we can add footer

and an option that contains do not show on title slide.
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Header and Footer ? X
Slide  Notes and Handouts
Indude on slide Preview
[ Date and time Date & Time )
Update automatically :__________E
[2271141 B | :
Language: Calendar type: e e——=
|Arabic (Saudi Arabia) ﬂ Umm al-Qura v
Fixed
23/11/41 : N\
[ St puumbes Slide Number
O f"m:( Footer D
J
[ pon't show ontitle 5M_(D0n’t Show on Title Slide)
sooy | [Aepiytoan]  cancet |

Also, from Figure 10- 22 we can write words in artistic ways by clicking on the

g

WordAst

option (

) that shows several styles and we can choose the style that we want

to apply as in Figure 10 -24. When choosing the style, we want to use, we add the

text that we want to write inside the style.

In'd':-di!:.ﬂ Date &  Slide Object
. Time Number

A A A
A A
A A
A A

A

Eguation Symbaol

it O

Through this group, you can add:

* Date and time by clicking on the option ( E:'Cl)), and when clicking on it, the

same screen appears in Figurel0 -23.

e We can insert the slide numbers through option (| = |), which by choosing it

also shows as in Figure 10 -23.
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* Alsowe find inside the text group there is another option which is the ability

to add an object by clicking on the option ( [_1) and when pressed it the screen
appears as in Figure10 -25.

Insert Object ? X

Object type:

(® Create new Adobe Acrobat Security Settings Document ~ | [ Display as icon

O Create t-rom file Adobe LiveCycle Designer Document
= Adobe Photoshop Image

Adobe Photoshop Image 13

Bitmap Image

Flash Document
Microsoft Eauation 3.0 N
Result
Inserts a new Adobe Acrobat Security Settings Document
@'T‘_ object into your presentation,
lak
Figure10-25: —

Insert Object

e

We find that the option insert an object enables us to insert equations through
which we can write an equation or files (pdf) and save it with a PowerPoint
document, and through it we can choose the document that we want to insert
as there are many other options that can be inserted through the object option.
Table 7 -10 shows all options and clarifies their required icons.

Table 710-: Shows the icons in an insert group

Option Name Icons

Insert new slide |
. =
Insert new slide theme

New

Slide ~
Insert table D
Table

| lagl

Insert photo from internet s
nline

Pictures

Insert photo from screenshoot e+
Screenshot
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Option Name Icons

Insert picture from the computer

Fe

-

Insert text box

Pictures
Insert image from photo album L
Album *
=’
Shaps S
Chart l l
Chart
Insert SmartArt SmartArt 15
Hyperlink oo
Hyperlink
Action [
Action
+
Comments ij
Comment
=]

Box

Header and footer

=

Header
& Footer
Insert word art 4
WordArt
Insert time and date F(';
Insert Slide number (=]
Insert an object (=}
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7. Symbols group: This group is considered one of the groups through which
we can insert any symbol inside the slide, especially mathematical symbols that
are not present on the keyboard. An symbol option (.2, can be used to insert a

symbol that is not present on the keyboard and when it pressed:

e |dentify where we want to add the symbol.
L9

e Goto "Insert tab" and choose symbol option (.5.).

e Many symbols appear to us as shown in Figure 10 -26
e Then we choose the symbol we want.

e Then press the "Insert" button to apply the option.

Symbol 7 X
Font: | (normal text) v | Subset: Currency Symbols v
B« 7|n8 26 al2]¢|7|2/s]enp)e"
BIO)|%]| € [Ne|®|™|™(Qle|d|%|1|%|%]|%|%
%% | %|%| %% |%| % V[0 [T
RiAN| O [ATTIS| | /] |[V|e=L|n]|],
Recently used symbals:
€L ¥|O]®|™[t]|2|<|2|+|X|eo|n|alB|m
Figure 10-26:
Ismyr:{)toal z:::osn::nname: Character code: | 20AC  from: Unicode (hex) v

A

Alsointhe case ofthe needtoaddamathematical equation orany mathematical
symbol, we can do that through the option equation (.’%..) and when you pressed
it allows the possibility of inserting or writing any equation as in Figure10 -27 that
enables us to use an existing equation or create a new equation. Table 10- 8 shows
the icons in a symbol group.
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Area of Circle -

Binomial Theorem

n
(x+a)" = Z}(z)_x-kaﬂ—k

Expansion of a Sum

nx nin—1)x2
1! ST 21

(1+x)" =1+

Fourier Series

: r nitx TLIT X
f'[_:r)=ﬂﬂ—|—Z(ancn i )
n=1
Pythagorean Theorem
aZ+b?=c?

JL Insert New Equation
[#] InkEquation

Table 10 -8: Shows the icons in a symbol group

Option Name Icon

T

Fquations

Q

Symbol

Insert equation

Insert Symbol

8. Media group: This group is the last group within the insert tab and through

it a video can be inserted by pressing the command ( 5= ) or sound ( =) andit
is also possible to record and add sound to the slide ( et ). When adding a video,

.......

clicking on the video option, and when clicking on it, the screen will appear as in
Figure (228-), which allows us to add video via the internet and in this case you
must be connected to internet or the option video on my PC and then you choose
the video you want to insert. Also, in the case of the need to record a sound, two
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options appear to us, one of which is choosing the voice from the computer or
recording the sound. As in case of using the other option to record and add sound
to the slide, the options in Figure 10- 28 show to us.

Insert Audio) ? Insert Video )

{ .. L] € L.
Audio  Screen Video Audio  Screen
*  Recording hd i Recording
o) Audioon MyPC.. |Eg Online Video...
Record Audio... ] Wideo on My PC...

Record Sound 7 =

Mame: |Recorded Sound |

Total sound length: O

[ |
oK | cancel |
‘Record Sound)

Table 10 -9 shows options within the media group with their icons.

Table 10 -10: Shows icons in the media group

Option Name Icons
Insert video Video
sound Audio
. -
Screen recording S:re:n
Recording
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10- 8 Design Tab

Skill10 - 6
Working with Design Tab

The Design tab consists of several groups (or commands) such as a themes
Group, variants group, and customize Group, as in Figure10-29. Also, some groups
will have a small button in their lower right corner. Clicking this button will open
lists with more features associated with that group.

@( Themes Group ) (' Customize Group
o Variants Group o

s\

College of Computing and Information
Technology
Microsoft PowerPoint 2016
Figure10-29:
Working with
Design Tab

Aoz Pk fowze Leri Weosewn: (90 EF W T -

1. Themes group: It is the group through which one of the themes is chosen to
apply to the slides as in Figure10 -30. Once you have selected a specific theme you
must choose a design from set of different designs in order to apply the theme to it.

C Themes Options )

This Fresentztion

Figure10-30: Enakiz Content Updatzs faom Office.com.
Themes
Options

B Browsefar Thems: C Browse for Themes )
5 Seve Cument Themes C Save Current Theme )

Introduction to Computer Skills 327 -




Introduction to
.............................................. Computer Skills

2. Variants group: In this group we choose the theme that we want to apply
to the slide as in Figure1031-, which gives us many options through which it can
be added to the slide such as color options, font options, effects, and in addition
to the styles that we want to apply which gives strength to the presentation.

( Variants Themes

.|

n Colors ( Colors Options

Figure10-31: Fonts 4—@( Fonts Options )
Variants
Themes D Effects C Effects Options )

Options

&) Background Styles C Background Styles )

3. Customize group: This group enables us to choose the slide size by pressing
the slide size option ([~ 1) or formatting the slide background by pressing the
background format option ([ <*). And when choosing the slide size option, it
allows us to choose the available size that we want to apply to the presentations.
In the case of the need to change the format of the background, we can through
the option format the background that provides us with several options, as in

FigurelO -32 through which you can arrange or hide design elements by the
current design.

Format Backgroun d)
: 1] &5
b - Slide

Form at

Size -~ Backgrowund
Customize o~
Format Background B
- Fall
5 Sold fill Solid Fill )
Gradient Filla— Gradient Fill )
Picture or textups£ill|
S < Pattern Fill )
Hide backomso o Hide Background )
Color L -
Figure10-32: Transparency | O 2 -
Format
Background
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10- 9 Transitions Tab

Skill10-7
Using Groups included in Transitions Tab

The Transitions tab consists of several groups (or commands) as in
Figure 10- 33, such as:

e Preview group.
e Transition to this slide.
e Timing group.

Also, some groups will have a small button in their lower right corner, clicking
on this button will open a list with more features related to that group and it is
related to the slide as a whole in case of needing to add a transition method.

College of Computing and Information
Technology

: Microsoft PowerPoint 2016
Figure 10-33: :

Transitions
Tab

1. Preview group: It is the group through which a preview for the selected
transitionto this slide is appliedas in Figure 10- 34. Once you have chosen the
transition, it will be immediately performed, and the shape of the preview
command will turn into a preview with a star during the execution.

Q Preview before Execution )

@ (Preview After Execution)
Figure10-34: LI ’ |'i§_?' <—@
FPr

Preview
group

EVIewW Preview

Preview Prewview
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To apply the commands in Figure 1034-, first you must determine the transition
from the second group, after which the command can be executed or paused.

2. Transitions group: It is the group through which a transition (animation) is
chosen to be applied on the chosen slide and we find that there are many options
for animations that can be applied to the slide as in Figure 10- 35. Once you have
chosen the transition it will be done directly,and the shape of the preview turns

into a preview with a star during execution. Also, through the effect options,
several effects can be added to the transitionsuch as the effect being vertical or

horizontal.
ql Transitions Group )
Figure10-35: B E é ﬂ *'H @ M : H@—
Uncower Bfedt
Opticns -

Trans_i tions hane Cut ade Push Wipe Sl Reveal  RandomBars  Shape
Options

-

I Transition fo This Slide I

3. Timing group: |t is the group through which the way to add sounds to the
slide during the transition is chosen, and through it the timing of the transition
between slides can be determined as in Figure 10 -36.

? Sound Option ) Time Execution)
'., Sound: [NoSound] ~ Advance Slifle

Figure10-86- | (1) pyrtion: 0340 ¥ OnMaogse Click
Timing

Group E‘, pply To Al After: |00:00.00 .

Timing

Duration )

We find on using sound options, they help us to choose the appropriate sound
among the existing sounds that we want to show during the transition between
slides while we find the (duration), it helps us in determining the duration of the
transition to the next slide while the option of (after) means the duration of the
slide and then the transition to next slide. Finally, after choosing the animation
you want to apply and you want to apply it to all slides, just click (apply to all).
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10- 10 Animations Tab

Skill10-8
Using the Group included in Animations Tab

The animations tab consists of several groups (or commands) such as preview
group, animation group, advanced animation group, and timing group, as in
FigurelO- 37. Also, some groups will have a small button in their lower right
corner, clicking on this button will open a list with more features associated with
that group and animations tab to makethe animation for part of the text or the
entire text in the slide.

o Advance Animation) Timing)

-\

College of Computing and Information
Technology

. Microsoft PowerPaoint 2016
Figure10-37:
Animations
Tab

e B U E W T - )

1. Preview group: It is the group through which a preview of the selected
annimation from the options of animations or advanced animation is applied.
Once you choose the animation it will be performed directly, and the shape of
preview will turn into a preview with a star during the execution and the animation
is performed on a specific text, picture,or anything inside the slide.

2. Animation group: This group contains number of animations that can be
applied on theselected text in the slide as in Figure10- 38. First, you must select
the text and then choose the animation that you want to perform. Also, the

effect of the selected animation can be changed by choosing the effect options
(Os?: ) Also, there is the ability to add effects to the entrance and exit of the

animation according to the type of effect.
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Figure10-38: *
Animations i
Options * More

3. Advanced Animations: This group contains number of animations that
enable us to add animation to the selected objects and then it will be considered
as a new animation that can be added after adding the originall animation from
a group of animations and in the case of execution of another new animation it
allows us to do so. Figure10- 39 shows all the options in this group.

** o Anlmatlon Pane
Figure10-39: Trigger o

Advanced
Animation

Ammatlon - Animation Painter
Advanfed Animation
@ romatenamr)

We find that after adding the animationwe want from option (1), other options
will be automatically activated and can be applied, such as option (2), which
allows you to preview and edit the timing of the animation. We also find option
(3) enables us to copy the animation to apply it to several objects through double-
click on the Animation Painterand we can apply it using the shortcut (Alt + Shift
+ C). Finally, we find the fourth option that tells us how to apply the animation,
when you click the mouse or on bookmark.
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How to Use the Groups included in Slide Show Tab

® Practzcal Part ® Part Chapter
Microsoft PowerPoint

The Slideshow tab consists of several groups (or commands) such as Start Slide
Show Group, the Setup Group, and the Monitors Group as shown in Figure10 -40.
Also, some groups will have a small button in its lower right corner.

Monitors )

(1) StartShdeShow) @)( setup )

Figure10-40:
Slide Show
Tab

College of Computing and Information

Technology

Microsoft PowerPoint 2016

witi Wiaswers UL B2

1. Start Slide Show group: It is the group through which several options can
beperformed on the slide as shown in Figurel0 -41. Option (1) allows us to start
the slide show from the first slide of the presentain, as we can also press the key
(F5) on the keyboard or click on the figure (¥).In case of the need to start from
the current slide that appears on the screen,we can choose option (2). As for
option (3), we can perform the presentation via the Internet. To do so, you must
have an account of Microsoft Office that allows others to see the slides in a web
browser. As for the last option, if we needtoshowcustom (selected) slides, we can

choose option (4).

Figure10-41:
Start Current
Slide

CIIFrom Beginning) GI Present Online)

ES
L’I—

From
Eeginning

B B B

o= e

From Present Custom Slide
urrent Slide  Online = Shaw -~

Start Slide Show

From Current Slide)

(Custom Slide Show)
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2. Set Up group: It is the group through which several settings are applied
on the slide as shown in Figurel0 -42. We find that option (1) allows us to adjust
setup for slides from advanced options that appear in slides.

Set Up Slide Show) Record Slide

F‘ /b Play Narrations
I'-. .-'I"I

. — |/ Use Timings
SetUp  Hide Rehearse Record Slide

Slide Show Slge  Timings  Show+ L/ Show Media Controls
Set Up

& Hide Slide ) &Show Media Controls)

When we press option (1) the screen appears to us as in Figure10- 43, which
gives us several options for the show and upon completion of all the settings
mentioned in the screen we can click OK to apply.

Set Up Show ? X
Show type Show slides
(® Presented by a speaker (full screen) ® an
() Browsed by an individual fwindow] ) From: L] 10 [7 =

O Browsed at a kiosk ffull screen) Custom show:

Show options L

|:| Loop continuously until 'Esc’ Advance slides
] show without narration
] show without animation
I:I Disable hardware graphics acceleration

() Manually
(®) Using timings, if present

Pen color: - Multiple monitors

K

. Slide show monitor:
Laser pointer color: Q -

Automatic Z
Resolution:
Use Current Resolution v ‘

] Use Presenter View

[ ok | cancel

As for option (2) in Figure (10 -42), it enables us to hide specific slides from
the presentation, and these slides we want to keep in the presentation and do not
delete them. This is done only by selecting the slide and pressing the command
Hide slide. Also, you can use this option during exercising the timing of the slide
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show by recording the show time. As for option (3), it helps and allows us to record
and show slides with audio narration and laser pointer, and it also allows us to start
recording from the beginning or from a specific slide. As for option (4), it works
to show the controls of the audio and video clip while moving over it during the
show, we can also use playback show to run the audio narration and determine
the play time for the animations and timings during the show.

3. The Monitors group: This group has two options to be applied on the slide,
as in Figure10 -44. In Option (1), the monitor allows us to automatically selection
of the monitor or selection of a specific monitor. As for option (2), use presenter
view, it allows us to show the slides in the full screen mode or the normal mode,
or use the option (Alt + F5).

Automatic -
Figure10-44:

Monitor |+ Use Presenter View |

MMonitors
Use Presenter View )
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Microsoft Excel

@ Main objectives:
1. Using the Excel worksheet program with high skill.

@P Secondary objectives

After studying this chapter, the student is expected to master the following
knowledge and skills:

Learn how to insert data into cells.

Learn about keyboard utilitizes on a sheet.

How to edit cell content.

How to find, replace and go to a specific location on the sheet.
Recognize ways to copy, move and delete cell contents
Learn how to sort cells in ascending or descending order
How to Freeze Panes.

. How to use mathematical formulas and functions.

10. How to use arithmetic operations.

11.How to write formulas of arithmetic operations.

12.How to use the mathematical Functions Application.
13.Learn about ways to insert an image.

14.Learn to insert text.

15. Learn to insert automatic shapes.

16. Learn to insert chart.

N U A WN
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11- 1 Introduction

In this chapter we will review number of skills that a student can learn to
be able to use Microsoft Excel 2016 or what is known as the excel worksheet
program, and all of these skills are only related to Microsoft Excel 2016. One of the
most important things that the student must learn in this chapter is to knowthe
new features ofMicrosoft Excel 2016, how to work with its interface, use and
edit worksheets, and work with the document as a whole. It is also necessary to
master dealing with various mathematical data and formulas, as well as dealing
with objects, diagrams, and charts.

11 -2 Micrsoft Excel

The Excel worksheet program (Microsoft Excel) is considered one of the
Microsoft office programs, and it is specialized in creating Excel worksheets, as
it provides a set of many features that makes the process of creating and editing
excel worksheets and their display method is unique so that any user canapply it.
Microsoft Excel 2016 is the 15th edition. It is also considered one of the effective
programs in the electronic table, whereby it is possible to create, delete and edit
cells so that they appear sequentially, automatically or interactively, with the
addition of animations and sound effects accompanying the animation. Also, the
Excel program used enables the user to share files with others. Also, it is possible
to save editable file with Excel format, or an automatic display to run it without an
Excel program on the computer. It also allows easy handling of graphs and faster.

11 -3 Design Features Using Excel

Many of us are looking to learn programs that help them organize mathematical
data, and some even buy programs at expensive prices and sometimes, they
discover that the program they bought does not fulfill the purpose.So, we find
that sometimes Microsoft Office Excel package programs make you do not need
to other computations programs.

The most important features of Microsoft Office Excel 2016 are:

e |tis possible to calculate the income and expenses of a specific company
efficiently.

* Analyze data and display the data to the user in the desired form.
* Create calculations that clarify the status of the institution or company.

e We do not need to go back tocalculations once graphs have been created
and data can be saved, arrenged and restored at any time.
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e The program works to reduce the time in calculations. Once a single cell
is calculated, you can apply the first calculations to the rest of the cells by
dragging the left mouse button and from the box in the rightmost corner,
which gives speed in the calculations.

e The use of the program enables you to insert data that may take time to
write down.

e The program manages the tables and we can copy and paste the cells
efficiently.

Skill 11 -1
Learn How to Create, Open and Close €xcel
worksheet Program

11 -4 Create, Open, and Close Excel Worksheet Program
To open and run the Excel Worksheet program, follow these steps:

e From the Windows 10 Start menu: Click the left mouse button on the
Windows icon, as shown in Figure 11 -1.

e Click on All Programs as in Figure 11- 1
e Then enter the application software and search for Excel 2016

e By typing directly into the Excel 2016 search box and then pressing the left
mouse button for Excel to open.

Figure11-1:
To Open
and Run the
Excel

Program
d ® 8 9 o B @ a |

Sorven ) @(Seameon)
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e Orfrom the desktop by pressing the right mouse button on a free space of
the desktop and then choosing New then the Microsoft Excel Worksheet
program or Excel.

After opening the Microsoft Excel program, the main program dialog box will
appear as in Figure 11 -2, where it can create a new workbook file, use an existing
Excel file, or use a ready workbook.

o Recent Excel Files ) Search for Online Templates) o
| | Eeprm——— ]
"“""(Close
Button

2 : = e

o b N Ve,

b | . = :

2

3 oo e s
Figure11-2: b E [, ¥ | M r_ H
Creating or B ‘ o
Opening an ] - e
Excel File [

e Open Other Workbooks ) (c&u% a Ready Excel Template)
Skill11-2

Learning How to use the Main Interface of Microsoft €xcel 2016

The main user interface for Microsoft Excel 2016

Before you start working with Microsoft Excel 2016 program, you must have the
ability to know the main user interface for this program, and we find that once you
open the Excel worksheet program (Excel) and choose the workbook, the figure
113- will appear. Also, the main user interface contains several tabs and inside each
tab there are number of groups and inside each group there are number of options
and the most used tabs in the Microsoft Excel 2016 program are:

e Filetab

e Home tab

e Inserttab

e Page Layout tab
e Formulastab

e Datatab

e Review tab

e View tab
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Ribbon Tab

: 1
Figure11-3: ©
The Main =
Interface of 2!

Excel 2016 |
Program sheott [T ) ;
..... [ B m m - [l T |

7 | The Worksheet e

The main workbook of Excel worksheet after opening it contains several
components as in Figure 11 -3, and we can mention:

1. Customize Quick Access Toolbar: The Quick Access Toolbar can appear
above or below the bar. In order to change its location, click on the drop-
down arrow to the right of the toolbar and click on (Show Below the
Ribbon). Also, through this toolbar the user can open a new document or
save or print a file and there are also other options inside it.

2. File Tab: it enables the user to open a new workbook, print, save a file, or
open an existing file inside the computer or in one of the storage media.

3. Ribbon Tab: By default, in Microsoft Office Excel 2016 there are more than
ten tabs (except for the File menu). Sometimes you will see editing tabs
that appear when working on a special type of object.

4. FormulasTab: It is a bar next to the name box, in which the user can write
the appropriate mathematical formula that he/she wishes to perform, and
it also shows the content of the active cell.

5. Toolbar:It contains number of options that enables searching, replacing,
selecting, editing, and others.

6. Status Bar: It is the bar through which the workbook screen is enlarged and

minimized. Another option is to go to the view tab and choose the option
zoom in or out according to what you need.
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7. Theworksheet: Itistheregionthatconsists of several rows and columnsand
their intersection with each other is called a “cell”, and the cell is activated
by clicking on it as in the above figure and the active cell is surrounded by
a green frame so we find from the figure above the H5 cell surrounded by
the green frame and now we find the name H5 is obtained from that the
letter H represents the column and the number 5 represents the row.

e The main user interface in the Excel program after opening allows us to
create another new workbook by going to the "File" menu and clicking
the left mouse button on the "New" option and then we choose "Blank
workbook" or we can directly press the keys (Ctrl + N).

* To open an existing Excel file, we click on the “File” menu and click on the

“Open” option. The options in Figure 114- appear to us, or we can press
the keys (Ctrl + O).

o Open File ) @Recent Excel Files)

Figuer11-4:
To Open
an Existing
Excel File

e Tosave afile fora new workbook in the Excel worksheet program, there are
two methods, as in Figure 11 -5:

1. The first methode “Save”: Click on the “File” menu and choose the “Save”
command, and this option is used to save a new workbook or in the case of
saving the updating that wes made to the opened workbook. We can also
press Ctrl + S to perform the command directly.

2. The second method “Save As”: allows us to save a new copy or save
another copy of the workbook while keeping the original.
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Save Excel
File

e To close the excel worksheet program, click the left mouse button on the
"X" icon in the top right of the open window, which closes the file or by
using the shutdown keys (Alt + F4).

Skill 11-3
Recognizing How to Change the Direction of the
Worksheet from right to left or vice versa

11 -6 Changing the Direction of Worksheet in Excel Program

We find that when a new workbook is opened in the Excel program, the
worksheetdirection will be from left to right, this means that the rows and columns will
be from left to right, so the following helps the worksheet’s users in the English language.
In the case of the need that changes the direction of the worksheet from right to left so
that users of the Arabic language can apply it as in Figure116-, we follow the following:

e Go that "page layout" tab
e C(lick on the "Right to Left Sheet" option to change the direction of the
worksheet from right to left.

o Page Layout Tab e Sheet Right-to Left

o T

m H—v—GII' he Columns from Right to Left) #

: 4—@XThe Rows Right-to Left )
KB
i
Figuer11-6:
Changing !
the »
Direction of E';
an Excel =

Workbook P
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11 -7 Changing the worksheet features inside the workbook

We find that when opening a new workbook at the beginning, it contains one
worksheet called “Sheetl”, so the Excel program allows us to change the name
of the sheet to the name we want, add other worksheets, or delete worksheets
and this is done as the following we stand at the “Sheet 1” option below The
worksheet then we press the right mouse button, and a drop-down menu appears
containing several options and we choose from it the option that we want to apply
as in Figure 11- 7.

Insert New Worksheet )

1

i «—X

3| e

- [ Do ] Rename Worksheet )
¢ I E”" - Delete Worksheet )
: —

Figure11-7:
Changing
the 11 :
Worksheet 2 o
Features 1 i
Inside the  °
Workbook oL et v

[‘ﬁ Protect Sheet...

Skill 11 - 4
Recognizing How to Deal with Cells, Rows and Columns

11 -8 Dealing with Cells, Rows and Columns

As we mentioned earlier, the intersection of any Column with Row gives a Cell.
In this section, we will know the following as in Figure 11 -8:

e How to select (select) a cell and this is done only by clicking with the left
mouse button on the cell we want.

e How to select number of adjacent cells, by clicking the left mouse button
on the first cell and then dragging the mouse pointer to the last cell and
then the cells have been selected. We find that the mouse pointer is pulled
in the direction of the row. This means that we have pulled cells that are
adjacent to a row. As for pulling the pointer in the direction of the column,
this means that we have selected vertical adjacent cells.

e Also we can select row and vertical adjacent cells at the same time by
selecting the first cell and pressing the "Shift" key on the keyboard and
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dragging the mouse pointer at the same time and then clicking on the last
cell with the left button of the mouse.

e Asfor the need to select spread out cells, we press the "Ctrl" key and then
at the same time choose the cells that you want to select by clicking on the
left mouse button in the cell you wish to choose.

Note: To insert text or number into the cell, this is done by selecting the cell
in which we want to insert the text or number by clicking on it with the mouse,
and then we write the text or number directly as in Figure118- and we can move
through the cells using the arrows on the keyboard.

@X Select Non Adjacent Cells) @XSelect Adjacent Cells) @X Select Row cells )

G al 1 J K L 1 H 0 P Q
| 10 13 Y % 20 1i|
9 12 23 2 1
l—' 21 21
N 2
19 15 28
. 25 L] 1 55 23
Flgurel 1-8: N N 1 10 13
Selecting 24 ” 1
Cells 28 2 N
29 52 1 Select Vertical Cells

Skill 11 -5
Recognizing How to Delete Cells, Rows, Columns
and Worksheets

i

11- 8 -1 Delete Cells, Rows, Columns and Worksheets
Sometimes the user of excel worksheet program may need to delete a row,
column, or worksheet, or he may need to move some cells to the right or to the

left, or from top to bottom or vice versa. To apply these commands, the following
steps can be followed:

e Determine the cell or cells to be deleted by left-click.

e From the "Home" tab, click on the "Delete" icon at the top of the sheet, as
in Figure 11- 9, and then several options for deletion appear.
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e When you click on the "Delete" option, four options will appear, namely,
delete cells - delete sheet rows - delete sheet columns - delete sheet:

* In the case of clicking on the “Delete Cells” option after selecting the
cells, the dialog box appears asin Figure 11 -10 which has four applicable
options and when choosing any of them press “OK” to apply.

Celete s )

Delete
() sShift cells left

Figure11-10: ' Entire row

Delete Cells  _? Entire column
Options

I YK I Cancel

e |If you press the “Delete Sheet Rows” option inside the “Delete”
option located on the “Home” tab, the selected rows will be deleted

automatically.

e |If you press the “Delete Sheet Columns” option inside the “Delete”
option located on the “Home” tab, the selected columns will be deleted
automatically.

Note: There is another way in which you can delete rows, columns, or cells by:

e Determine the rows, columns, or cells you want to delete directly.
e Clicking the right mouse button and choosing "Delete" from the menu that
appears as in Figure 11- 11.
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Figure11-11:
Delete from
Drop Menu

e We find that the last option in the "Delete" menu is "Delete a sheet". If
you click on the "Delete a sheet" option, as in Figure 119-, you will see a
message explaining that to delete the current worksheet, the workbook
must contain more than one worksheet. The deletion cannot take place if
there is only one worksheet as in Figure11- 12.

Figure11-12:
A Sheet
Deletion i
Message | @

Shsett

A Sheet Deletion Message )

Skill 11 - 6
Recognizing How to Insert Cells, Rows, Columns and
Worksheets

11 -8- 2 Insert Cells, Rows, Columns and Worksheets

Sometimes user of the Excel worksheet program may need to insert a row,
column, or worksheet into the currently open workbook. In this case, the user
must follow the following steps:
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e Select the cell or cells to insert cells before or after by clicking with the left
mouse button.

e From the "Home" tab, we click on the "Insert" icon at the top of the sheet
as in Figure 11- 13-A, so several options for insertwill appear as soon as we
choose any of the four options.

* The selected option will be performed directly.

Insert Option
-----
- % [k i (|l x5 s - e }:
e Bt [T 2 Casttimul famew Col Duety Pt st fnds
...... Tarremry LT 2 : Tt v St
...... 1 B
2 A B t o E F [3 ] | d L ] (s]
1 Name First | Second | Toall —
2ffa | 2 [ 20 | &
3 Alla 23 o] 48
4 Mustafa -] 25 50
5 Abmed 2 25 a7
B Al | 22 2 44
T Abdalrazg 24 1 47 1
8 Ao B - ~ Insert Options
8 Madar 4 Fil 45

2l - .

Note: There is another way in which you can insert rows, columns, or cells by:

e Determine the rows, columns, or cells you want to insert directly.
e C(lick the right mouse button and choose “Insert” from the menu that
appears as in Figure 11- 13-B.

e ¥ g [5 B W[5 Zeendy O
m 3 U 2 Tre- Fi
Mo+ ' Codbosfomdm Ll pet Dewsfome Sei Fred
Toreetng® Tk Hye £ e Tl e
H | 4 K L M N o
B m i

Insert Option
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Skill11-7
Recognizing How to Change the Sheet Name

i

11 -8 -3 Change the Sheet Name

Sometimes the user of the Excel worksheet program may need to change the
name of the sheet to another alternative name, and this is done through one of
two options:

1. The first option: by double-clicking on the name of the sheet whose name

we want to change then we write the new nameand press Enter.

2. The second option: we right-click on the name of the sheet whose name
we want to change and then a menu appears containing several options we
choose the option “rename” and then we change the name and click Enter
as in Figure 11 -14 or click the left mouse button to complete the editing.

A B c o E £ G H | J K L
1 Name First S d | Toatl
2 Fahd 23 20 43
3 Ala 23 25 48
4 Mustafa &5 | B 50
5 Ahmed 22 25 47
Ban | 22 T 2 | 44
7 Abdakrazg 24 23 47
8 Amro | 24 23 47

9 Nader 21 | 45
10 -

Figurel1-14: 12
Rename :3
Sheet 15

Rename Sheet

Skill11-8
Recognizing How to Change the Size of Column and Row

11- 8 -4 Adjusting the Size of Column and Rows

Sometimes the user of the Excel worksheet program may need to change
the size of a specific row or rows and enables him to adjust the size of a specific
column or columns by the following:

e We click on the row, column, or cell we want to resize.

e From the "Home" tab, we click on the "Format" option at the top of the

screen, and the menu appears to us as in Figure 11 -15.
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¢ To change the size of the row, we choose from the list that appeared when
clicking on the “Format” option, the option “Row height” as in Figure (11- 15).
A box will appear to us, as in Figure 1116-, through which we specify the size
that we want to give then we press the “OK” button to apply.

i 3] F
d | Toad |
20 43 |
25 48
25 2|
F5 7| | FT———
22 [T I
25 47 I
2 47 |
21 45|

Row Height

¢ To change the size of the column, we choose from the list that appeared
when clicking on the “Format” option, the option “Column width” as in
Figure 11- 17. A box appears to us through which we specify the size that
we want to give, then we press the “OK” button to apply.
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Format Option
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Note: There is another way in which you can adjust the size of the rows or
columns as follows:

e Determine which rows or columns we want to enlarge or reduce.

e We click on the left mouse button at the beginning of the row or column
and then drag according to the desired size as in Figure 11- 18.

Column Width

4 Mistafa | 25 25 50
5 Ahmed | 22 % [
& Al 7] 2 [
7 Abdakazg) 24 23 47
8 Amo M| N | 47
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Skill11 -9
Insertion of Cell Data

11 -9 Insertion of Cell Data

Data for each of (numbers, texts, dates) can be inserted into cells - as in Figure
11- 19 - by the following steps:

e To select the cell to be written on: Click the left mouse button on it or use
the keyboard to access it.

* Write the text, number, or date directly in the box. The date is usually
written in the form of (day / month / year).

e Press Enter to fix the data and move to the next cell.

L2 -

Formulas Data Review

Lo X Cut .

- Arial 1 -~ A A
=g Copy ~
Past . .
3' : Format Painter B IU -&
Clipboard la Font M
Al v X « f | UniversityiD]
A |
A B C D E | F
1 [erstyD |
Figure 11-19: 2
Entering Data 3 -
into Cells 4: Glere Enter the Data Reqwred)
5—
6
For example, to insert the following data:

University ID First Name Last Name Specialization
1017891 Mohammad Khaled Computer Science
1027892 Moustafa Majid Information Technology
1037893 Ali Othman Information Technology
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Follow the following steps:

e C(lick on cell A1 and then it will select.

e Type the phrase (university ID) using the keyboard.

e Click on cell B1 and type (first name).

e Click on cell C1 and type (last name).

e Click cell D1 and type (specialization).

e Click on cell A2 and type (1017891).

e Click on cell B2 and type (Mohammad).

e Click on cell C2, and type (Khaled).

e Click on cell D2, and type (Computer Science).

* Repeat the previous steps to fill in the rest of the table as in Figure11 -20.

I —

" -
nsert Page Layout Formulas Data Revie
“ﬁ db Cut Arial M AN ===
Past EE] Copy ~ 3 ]
a's : ¥ Format Painter BIU-H- 24 =S==7
Clipboard Ia Font I
H4 M B
. A B G D
Figure11-20:
g ell Datao 1 University I0First Name | Last Name Specialization
Entry Form 2 1017891 |Mohamed  |Khalid Computer Science
3 1017892|Ahmed Nader Information Technology
4 1017893|Osman Ahmed Information Technology

11 -9- 1 The use of the keyboard on a worksheet:

e To move to a new row below the current row press (Enter)

e To move to a new column to the left of the current press (Tab)

* Todelete a cell’s content: Select the cell’s content by clicking on it and then
clicking (Delete).

e To go to the beginning of the line / row, press (Ctrl + Home)

e To move to the end of the line / row, press (Ctrl + End)

e To move to the beginning of the worksheet, press (Ctrl + Home)

e To view the rows down, click (Ctrl+Page Down)

e To view the rows up click (Ctrl+Page Up)

e To undo any error, press (Ctrl + Z)

e To return to the undone, press (Ctrl +Y)
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11 -9 -2 General rules for inserting the data

e From the figure, note that one element was inserted in cell A1 as a number
only and also for cell B1, and it is preferable to insert data in cells in this
way; because this later allows us to perform sorting operations easily for
the first name only or for the date modified and the contents of cells (A1,
B1, C1, and D1) are called from field or column headings.

e |fyouwanttoinsert new data, insertitin the fourth row directly, and do not
leave blank rows between the data because this may cause future errors
when performing the data sorting, as well as for the columns.

e |f you determinethe sum of the numerical data for a column, for example,
it is preferable to leave a blank row before the row in which the sum will be
inserted.

* Toinsert a specific number, select the cell and type the number directly in it. A
negative sign can be inserted in front of the number if the number is negative.

e Use the slash (/) or the hyphen (-) to separate the components of date. To
enter the current date in a specific cell, press (Ctrl +;)on the keyboard.

* Toinsertthe currenttime, press (Ctrl +:),i.e. (Ctrl+ Shift + ;) on the keyboard.

Skill 11-10
Recognizing How to €dit the Cell Content

11 -9- 3 Editing the Cell Contnet
To edit the cell contents with (add, delete, replace), follow these steps:

e C(lick on the cell whose content you want to edit, for example cell (D3) as
shown in Figure 11 -21.

- -

[nsert Page Layout Formulas Data

ol =
™ db Cut Arial AN T=E=
Paste = Copy BIU- H- O A =SB = ¢
. ¥ Farmat Painter - - -

Clipboard ] Font i
D3 v ) 2 Information Technology

A B c D
Figure11-21: | 1 University IO First Name | Last Name Specialization

Modifying 2 1017891 |Mohamed _ |Khalid C%
Cell Data 3| 1017892/ Ahmed Nader Information Techna®ay] |
4

1017893|0sman Ahmed Information Technology | |
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To add data: Move the pointer to the addition site, then start adding (text
or number ...) you want to add directly.
To edit the text (or part of it): Select the text to be replaced by highlighting
it with the mouse, insert the new text directly as shown in Figure 11- 22.
Page Layout Formulas Data Review
ﬁj f"‘cut Avial 1 AN = ¥
Paste =2 Copy - T A e [ —
¥ Format Painter Iy- o- 3~ A' =5 = 5
Clipboard [} Font &
D3 ¥ Je Information Technology
A B C D
Figure11-22: 1 University IDFirst Name | Last Name Specialization
Edit Textor | 2 1017891 Mohamed |Khaiid Enter the
Partofit | 3| 1017892[Ahmed  |Nader information Technd™®ay New Text
4 1017893|0sman  |Ahmed Information Technology Here

¢ Todelete the text (or part of it): Select the text to be deleted by highlighting
it with the mouse, press the “Delete” key as shown in Figure 11- 23.

3 -
Insert Page Layout Formulas
m f‘-‘c“ Avial ‘M AN =2 ¥
Paste <2 Copy ~ [T ” — [ —
= ¥ Format Painter IUu-H- - A FH= S
Clipboard [P Font G
D3 v = Information Technology
A B C D
Figure11-23: 1 University IDFirst Name | Last Name Specialization
Delete Text 2 1017891|Mohamed _|Khalid Computer Science |
or Partofit 3| 1017892/Ahmed Nader Information Technology
4 1017893|0sman Ahmed Information Technology

¢ To copy or Paste the text: Select the text to be replaced by highlighting it
with the mouse, press (Ctrl + C) to copy or (Ctrl + X) to cut, then go to the
second cell site and press (Ctrl + V) to paste as shown in Figure1124-.
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Skill11-1
Recognizing How to Find, Replace and Go to

11 -10 Find, Replace and Go to
11-10-1 Find
Excel worksheet program enables you to search for text or number contained
within the texts of worksheet cells, to search follow the following steps:
e Within the tab (Home) and from the group (Editing), click on the (Find and
Select) icon and the Find and Replace dialog box appears, or press (Ctrl +
F)on the keyboard, so that the Finddialog box appears directly as shown in
the Figure 11 -25.

Find and Replace

Replace

Find what |
 FindAl | [ EindNet | | Close |

e Find and Replace dialog box, select the (Find and Select) command, and
the finddialog box appears.

* In the (Find what) edit box, type the data you want to search for such as
(.....) asin Figure (11- 25)
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first position of data on the worksheet.

places that contain the data as shown in Figure1126-.
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Click the (Find Next) button and note that the pointer moves directly to the

Repeat clicking the (Find Next) button, and the pointer will move to other

Click the (Close) button to close the (Find and Replace) dialog box.

11 -10- 2 Replace

The excel worksheet program enables you to replace the value with a new
value on the worksheet. To make the replacement, follow these steps:

value.

Apply step (1) above in the find process.
Click on the (Replace) tab instead of (Find).
Perform step (2) by typing the value you are looking for and the replaced

2 B = ) E | F G H J_| K
Dmiversity I0 First Name | Last Name Specla]lzaglon Find and Replace 5 w
1017891 |Mohamed _|Khalid
1017892|Ahmed Nader Information Technology, Find  Replace
1017893/Osman Ahmed Information Technology v
Find what: Technology e
Options > >
Find All Close

Click the Replace button to replace the value in its location, or (Replace All)

to replace all the contents of the worksheet similar to the replaced value
as shown in Figurell -27.

Figure11-27:
Find &
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Click the (Close) button to fix the replacement, then close the dialog box.

Options >>
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Close
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5
6| Replace with 2
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11-10-3 Go to

The (Go to) command is used to quickly reach cells, columns, or rows, rather
than searching and moving between columns and rows to reach the desired one.

To move to a specific cell, follow these steps:

e Onthe (Home) tab and in the (Edit) group, click the (Find and Select) icon
and then click (Go To) or press (Ctrl + G) to show the (Go to) Dialog box or
press the (F5).

* Type in the cell number required to go to, for example (D1), then click the
OK button.

e You will immediately go to the desired cell.

e To return to the beginning of the worksheet you can follow the same
previous steps and insert the cell name (A1), or press (Ctrl + Home) as
shown in the Figurell- 28.

2

Insert Page Layout Formulas Diata Review

- . db Cut Arial ‘1 AR == = &~ - E‘WrapTﬂct General
Past =2 Copy - &
aste . 1. . === l== @,
. ¥ Format Painter BIu B D-A-=ESEE=EEE (= Merge & Center % *
Clipboard [ Font [F] Alignment = Mumb
& N ke GoTo 7 ®
A B C D —| Goto: u
1 University IO First Name | Last Name Specialization
2 1017891 |Mohamed  [Khalid Computer Science
3 1017892|Ahmed Nader Information Technology
4 1017893|0Osman Ahmed Information Technology
2
B
7
8 ;
Figure11-28: Reference:
Go to iType Here the Cell Number that You Want to Go to B
1 1 Spedial.., Cancel
12

Skill 11 -12
Recognize the Sorting of Cells ascendingly or descendingly

11 -11 Sorting cells ascendingly or descendingly

The excel worksheet program enables you to sort the data of columns either
ascendingly or descendingly, either alphabetically (A..Z) or digitally (9..0) by
following the following steps:
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e Select the cells of the column to sort the data on (with necessary to not
highlighting the headers of the columns).

* Tosort: Click on the “Sort” button in the “Edit” group of the “Home” bar, to
display a set of options as shown in Figure 11 -29.

A
oy
Here the Sort & Filter Options }——p|Sort & Find &
( Filter = Select -
8l sortAtoz
B2 S E | Mohamed Z| sortZtoA
A B C D E | Custom Sort...
1 University IO First Name| Last Name Specialization Y Filter
2 1017891 |Mohamed  |Khalid Computer Science
3 1017892|Ahmed Nader Information Technology
Figure11-29: 4 1017893|0sman Ahmed Information Technology
Sort & Filter 5
Options 6 |
? —
8 —

e For Ascending Sorting: Click on the (Ascending Order) option.
e For Descending Sorting: Click (Descending Order).

To sort all the contents of the rows according to the order of the values
(ascending / descending) in the required column as shown in Figure 11 -30.

Skill11-13
Rcognizing the Freeze Panes

11- 12 Freezing Panes

The word “freezing” means fixing number of cells so that they do not move or
disappear from the user’s sight even if the sheet is moved up and down, as well as
to the left or right, and the process (freezing) can be carried out by following the

following steps:

e C(lick on the cell you want to freeze the panes starting from it.

e (lick the (Freeze Panes) button within the (window) group of the (View)
tab to give options (Freeze Top Row, Freeze First Column, Freeze Panes)as
shown in Figure1130-.
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(Freeze Panes Options)—b

B2 v

A

B

fr | Mophamed

c

D

University ID

First Name Last Name

Specialization

1017891

Mohamed

Khald

Computer Science

1017892

Nader

Information Technalogy |

1017893

Osman

Ahmed

Information Technology |

|

GO = DN e D RS s

]

@ E Split EE[ View Side by Side ED-]
i _iHide [ Synchronous Scrolling

Freeze Switch
|_|Unhide [ Reset Window Position Windowd
Freeze Panes

Keep rows and columns visible while the rest of
the worksheet scrolls (based on current selection).
Freeze Top Row

Keep the top row visible while scrolling through
the rest of the worksheet

Freeze First Column

Keep the first column visible while scrolling
through the rest of the worksheet.

e C(lick the (Freeze Panes) button to divide the worksheet into four sections
fromthe (Freeze) cell and fix the top cells from the left side of the worksheet.

* To apply: Perform the previous steps, then move the worksheet down and
right, as the frozen cells will remain present whatever you move.

* Toremove the freeze: Repeat the steps (11 -12) with the option of (unfreeze
the panes) as shown in Figure 11 -31.

( Unfreeze Panes )—b

=

3 Split
™ Hide

[13 View Side by Side

| Synchronous 5

crol

ing

Panes~

Unhide

P31 Reset Window Position W

=

Unfreeze Panes
Unleck all rows and columns to scroll
through the entire worksheet

B2 ¥

A

B

fr | Mohamed

C

D

-1_

University I0First Name Last Name

Specialization

1017891

Mohamed

Khaid

Computer Science

Freeze Top Row

Keep the top row visible while scrolling
through the rest of the worksheet.

Freeze First Column

Keep the first column visible while
scrolling through the rest of the worksheet,

1017892

Anmed

Nader

Infarmation Technology

1017893

Osman

\Ahmed

Infarmation Technology

1
2
3
4
5]
6
T
B

Skill 11 - 14
Recognizing The Matimatical Formulas and Functions

11- 13 The Mathimatical Formulas and Functions

One of the most important features of Excel is the ability to use mathematical
formulas, through which different arithmetic operations are performed on the
values in worksheet cells.The program also contains large library of different
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functions divided into categories, including financial, statistical, engineering,
mathematical, trigonometrical, and other functions, to perform various operations
on the values in worksheet cells.In this part, you will learn how to use formulas
and functions in worksheets.

Skill 11-15
Recognizing The Arithmetic Operations

(il

11-13 -1 The Arithmetic Operations

The formula is an equation in which arithmetic operations are performed on
the values in worksheet cells, such as arithmetic and logical operations, which
range from simple arithmetic operations (multiplication, division, addition,
subtraction) to more complex operations like (mathematical functions), the
following explainshow to deal with these operations.

First: Succession of the Arithmetic Operations
Excel uses the known succession to perform arithmetic operations, that is:

1. Braces first, from inside to outside.

2. The power.

3. Multiplication and division from left to right.

4. Finally, addition and subtraction from left to right.

Second: Addition and subtraction of cell contents

e Click on the cell in which you want the result to appear in it, and then type
the sign (=) as in the Figure 11 -32.

IF v x v Kk =
A B C D
1 | Employee Name |[Basic Salary| Bonuses| Toatl
\ 2 |Mohamed Khair 1050 200 |=
Figure11-32: 3 |Monzir Faiz 1300 400 A
~ 4 Mogtaba Faiz 970 150
B 5 [Mohamed Rabee 1200 450
? - (The Cell to which the Result AppearsXD

e Click on the first cell of the cells involved in the addition or subtraction
process, and note that it will be outlined with dashed line after clicking and
the name of the cell will also appear in the resulting cell, as shown in Figure
11-33.
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A A
Employee Name
Mohamed Khair
Monzir Faiz
Mogtaba Faiz
Mohamed Rabee

@ells Involved with Addition and Subtraction Operations
T

N o Lo P —

e Write the sign (+/ -) after the cell name in the resulting cell as shown in the

Figurell -34.
A A B C D
1 | Employee Name [Basic Sala I atl
2 |Mohamed Khair 1050 200 1=C2
3 Monzir Faiz 1300
4 Mogtaba Faiz 970 150
5 |Mohamed Rabee 1200 450
6_
7

e (Click on the second cell that involved in the addition or subtraction
processand note that it will be outlined with a dashed line after clicking and
the name of the cell will also appear in the resulting cellas in Figure11 -35.

B2 i X Vv & || =BxC2
A A | B C D
1 | Employee Name [Basic Salary| Bonuses| Toatl
2 |Mohamed Khair 1050 200 l:BQTCﬂ_
3 |Monzir Faiz 1300 400
4 'Mogtaba Faiz a70 150
5 |Mohamed Rabee 1200 450
6_
B

* Press (Enter) to see the result directly on the result cell.
e Toinsert other cell values, repeat points (2 and 3) depending on the number
of cells involved in the process.
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Skill 11 -16
Recognizing How to Fill the Arithmetic Operations

i

Third: Filling the Arithmetic Operations

The excel worksheet program enables you to get benefit from automatic
copying of the arithmetic operations on a specific cell to the adjacent cells by
applying the (fill) command used infilling the formats and texts; as in Figures 11-
36 and 11 -37, and this is done by following the following steps:

e Click on a cell containing the result of arithmetic or logical operation.
e Set the mouse pointer to the small, dark square on the lower right corner
(+) of the cell.

D2 - I =SUM(B2:C2)
A B C D
1 | Employee Name |Basic Salary|Bonuses| Toatl
. ~ 2 |Mohamed Khair 1050 200 1250) |
Figures 11=36: 5 TMonzir Faiz 1300 400 Fa
Fillingthe 4 jjogtaba Faiz 970 150
ér't:r':t?;':s 5 [Mohamed Rabee 1200 450
P g \ ]| The Small Dark Square

e Then start dragging to the side (columns / rows) that the operation will be
performed on and parallel to the work cells in the main arithmetic operation.

D5 v 2
A B C D
1 | Employee Name |Basic Salary Bonuses| Toatl
2 |Mohamed Khair 1050 200 1250
3 |Monzir Faiz 1300 400
4 |Mogtaba Faiz 970 150
5 |Mohamed Rabee 1200 450
6
7
D2 v S =SUM(B2:C2)
A B C D
1 | Employee Name |Basic Salary| Bonuses| Toatl
Figures11-37: 2 |Mohamed Khair 1050 200 1250
. ° 3 |Monzir Faiz 1300 400 1700
Rilingthe == 1o 0taba Faiz 970 150 1120
Arithmetic 5 [\iohamed Rabee 1200 450 1650
Operations g -
7
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e The values of the arithmetic operation are immediately filled over all the
highlighted areas.

Skill 11 -17
Recognizing How to Apply the Mathematical Functions

(il

11-13 -2 Appling the Mathematical Functions

The function is a formula that was previously written in the program, and that
leads to one of the arithmetic or logical operations. Excel has a large library of
different functions, and the followingis an explanation of some of the common
functions in the program, and the function of each of them.

Skill 11 -18
Knowing the Calculation of the Average Function

First: Calculation of the Average Function:

The Average: the sum of the values divided by the number of values. To apply
the average function, we follow the following steps:

e C(Click on the cell in which you want to show its result.as in Figure11 -38.

| A B C D
1 | Employee Name |Basic Salary Bonuses| Toatl
- 2 Mohamed Khair 1050 200 1250
. 3 |Monzir Faiz 1300 400
MOUESTISE: 4 TMogtaba Faiz 970 150
Average 5 |Mohamed Rabee 1200 450
Funcon 6 Average
7

e Click the function button (FX) on the (Formula tab), and the insert function
dialog box appears directly.

e Click on (Average) and then click (OK), to immediately show the dialog box
for selecting cells whose average value should be calculated as in the Figure
11 -39.
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D6 v i x v kK | Insert Function ? X

d A B Search for a function: [
1 | Employee Name |Basic Salary| Type a brief deseription of what you want to do and then [ Go ‘ l
2 Mohamed Khair 1050 dick Go
3 |Monzir Faiz 1300 Or select a category: | Most Recently Used EI
4 M 970 Select a function:
5 Mohamed Rabee 1200
6
7]
8—
9 HYPERLINK *
16 COUNT v
11| “‘W“"“"'W‘ﬁselect a FunctiorD

< Returns the s, which can be

12 numbers or names, amays, or references that contain numbers,
13
14
15
16 Help on this fundtion [ox ]| conca

e Drag directly with the mouse on the values involved in the average
calculation and they appear as shown in the values box (D2: D5)

e (lick (OK), to display the value on the location chosen in Step (1).

D6 4 X +  Jfc | Function Arguments ? X
4 A B AVERAGE
1 Employee Name |Basic Salary| | Number! | D2:D3| %= = {1250;1700;1120;1650 |
2 Mohamed Khair 1050 Number2 * £8&| = number
Sl Monzir Falz_ 1300 (The Values Included in the Average Calculation)
4 Mogtaba Faiz a70
5 Mohamed Rabee 1200
6]
7| = 1430
8 Retums the average ic meanj of its which can be of names, arrays, or references
9_ that contain numbers.
1(]_ Numberi: numberi;number2... are 1to 255 numeric arguments for which you want
11_ the average.
12|
13_ Formula result = 1430
14
15 Help on this fundion E Cancel

e You can use (fill) in the rest of the cells using the previously explained filling

method.
D6 il I =AVERAGE(D2:D5)
A A B | ] D
1 | Employee Name |Basic Salarﬁ Bonuses| Toatl
2 |Mohamed Khair 1050 200 1250
3 |Monzir Faiz 1300 400 1700
4 Mogtaba Faiz a70 150 1120
5 |Mohamed Rabee 1200 450 1650
6 | Average | 1430
T
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Skill11-19
Knowing the Calculation of the Min and Max Functions

Second: Calculation of the Min and Max Functions

Max: A function used to determine the highest value among a group of cells
selected from a worksheet.

Min: A function used to determine the lowest value among a group of cells
selected from a worksheet.

It is calculated by the following steps:
e C(Click on the cell in which you want to show its result.

D7 = I
A B C D

1 | Employee Name |Basic Salary|Bonuses| Toatl

2 Mohamed Khair 1050 200 1250

3 |Monzir Faiz 1300 400 1700
Figuer11-42: 4 |Mogtaba Faiz 970 150 1120
Max Value 5 johamed Rabee 1200 450 1650
Calculations 6 Average 1430

7 Max Value

e C(lick on the function button (FX) on the (formula) tab, and the insert
function dialog box appears directly.

e C(lick onthe (Max) or (Min) option, then click (OK), to immediately show the
dialog box for selecting cells to determine its lowest or highest value.

D7 - X« fe | Insert Function ? X

A B Search for a function:
1 | Employee Name |Basic Salarﬁ Type a brief description of what you want to do and then Go
2 |Mohamed Khair 1050 dick Go

3 |Monzir Faiz 1300 Or select a category: Most Recently Used v

4 Mogtaba Faiz aro
5 Mohamed Rabee 1200
6

7

8

9

Select a function:

AND : A
KURT a Max Function

I HYPERLINK

OUNT
MAY

SIN

SUMIF v
MAX(numberi:number2;...)

Returns the largest value in a set of values. Ignores logical values and text.

Figuer11-43: 4
Max Value ¢4
Calculations 5

16' Help on this function Cancel
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e Drag directly with the mouse on the values involved in the Min or Max
calculations and they appear as follows on the values box (D2: D6).

A | B Cc D E_ | F | G | H |
1 | Employe ;nction Arguments ? X
2 |Mohamed
3 [Monzir Fa MAx
4 Mog!aba F | Numbert DDl % = {1250;1700;1120;1650;1430} |
5 |Mohamed Number2 Bl = n +
6
‘ = GIThe Values Included in the Max Value)
8 |
9 |
10| = 1700
11% Returns the largest value in a set of values. Ignores logical values and text,
12% berl: numberl;number2;... are 1to 255 numbers, empty cells, logical values, or
13% text numbers for which you want the maximum.
Figuer11-44: 14
Max Value 15
Calculations 164 Formula result = 1700
17j Help on this function Cancel
18

e (lick (OK), so that the value appears on the location chosen in Step (1).

D7 - Jfe || =MAX(D2:D6)
A B , C D
1  Employee Name Basic Salary{ Bonuses| Toatl
2 Mohamed Khair 1050 200 1250
3 |Monzir Faiz 1300 400 1700
Figuer11-45: 4 |Mogtaba Faiz 970 150 1120
Max Value 2 Mohamed Rabee 1200 450 1650
Calculations °© Average 1430
7 Max Value| 1700
8

Skill 11- 20
Kowing the Calculation of the Sum Function

Third: Calculation of the Sum Function:
Sum function is used for the automatic addition operations.

The AutoSum button performs the addition function, and can be handled by
following these steps:

e Click on the cell in which you want to show its result.

e C(lick the (AutoSum) button on the (Home) tab within the (Editing) group to
automatically select the column or row.
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e Dragdirectly with the mouse on the values involved in the addition process,
and it appears as follows on the values box (D2: D7).

e Pressthe (Enter) key to display the value on the location chosen in step (1).

1 > 2 AutoSum| - p

* Sort & Find &
(The Sum Cells Y2 ) == Filter - Select~
Editing
A B C &' E F

1

Employee Name |Basic Salary Bonuses| Toat

1

2 |Mohamed Khair 1050 200 1250
3 Monzir Faiz 1300 400 1700
4 |Mogtaba Faiz 970 150 1120
5 Mohamed Rabee 1200 450 1650
6
7
8
9

Average | 1430
Max Value} 1700

Figuer11-46:
AutoSum

Total  [=Sum(D2p7

SUM{number1; [number2]; ...

| am going to obtain the sum of the numbers in column B, select cell B8, go to
the (Home) tab, then click on the (AutoSum) button. Or select the cell and press
(ALT+ =).

Skill 11 - 21
Kowing the Calculation of Condition Function (IF)

Forth: Calculation of the Condition Function (IF)

Condition Function (IF) is used to test the cells values so that it gives a certain
value that confirms the condition, and it uses the comparison conditions (=, <,><>,
....). To deal with this function, follow these steps:

e C(Click on the cell in which you want to show its results.
e C(lick on the function button (FX) on the (formula)tab, and then the insert
function dialog box appears directly.

- 370 Introduction to Computer Skills




® Practical Part Chapter @
c
4 A B o D E Fo
1  Employee Name [Basic Salary Bonuses| Toatl |Salaryis higher than 950
2 |Mohamed Khair 1050 200 1250 |=
3 Monzir Faiz .
Insert F ? X
4 Mogtaba Faij "
5 Mohamed R{ Search for a function:
6 Type a brief description of what you want to do and then Go
T click Go
8 Or select a category: | Most Recently Used E
190— Select a fundtion:
1 MAX
11_ AVERAGE -
12
13 |
14 IF Functi
15‘ | HYPERLINK v
16 1 IF(logical_testvalue_if_true;value_if_false)
- Checks whether a condition is met, and returns one value if TRUE, and
17 another value if FALSE.
18
19
20
21 Help on this fundion | oK I Cancel I
29

Microsoft Excel

Click on “IF” then click “OK”, then a dialog box will appear to define the
condition (logical test)

Write the values resulting from the verification of the condition or not in
the fields (Values if True), (Value if False), respectively. For example, if the
salary is greater than 950, type “good” and if less than write “acceptable”
as shown in the Figurel1- 48.

Checks whether a condit|on is met, and returns one value if TRUE, and another value if FALSE.

Logical_test is any value or expression that can be evaluated to TRUE or FALSE.

-
[=7]

- —
DIN

A A B c D E | E | G |
1 | Employee Name |Basic Salary| Bonuses| Toatl |Salary is higher than 950

2 |Mohamed Khair 1050 200 1250 |=IF(A2=950;"Good","acceptable")
3 Mon Functien Arguments ? X
4 Mo

5 Moh [F

6 Logical_test | A2>950 F% = TRUE

7‘ Value_if_true "Good' = "Good"

g— Value_if_false "acceptable' = ‘acceptable’

10 = “Good'

1"

12|

13

14

15

Checking Whether the Condition is Met or Not)

Formula result = Goo

[ o ]| cance

Help on this function
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e (lick (OK) to see the results directly on the result cell.
e Perform the filling process as shown in Figure 11- 49.

- -

A B C D E F o
1 | Employee Name [Basic Salary Bonuses| Toatl [Salaryis higherthan 950
2 |Mohamed Khair 1050 200 1250 |Good
3 |Monzir Faiz 1300 400 1700 |Good
4 |Mogtaba Faiz 970 150 1120 |Good
Figuer11-49: 5 [nohamed Rabee 1200 450 1650 |Good |
The IF 6 Average 1430 =]
CFIIJnCItIO_n 7 Max Value| 1700
aleulation g Total 1 ) The Results

A Table shows the descriptions of functions according to their importance and
the most used: whether:

Function Description

SUM This function adds all the numbers in a range of cells

IF This function checks whether a condition is met, and returns
one value if TRUE, and another if FALSE.

COUNTIE This fqnc‘non is used to count the number of cells that confirm
specific condition

ABS This function is used to obtain the absolute value of the
number

ACOS This function returns the arccosine of a number
This function extracts from a database a single record that

DGET o .
matches the conditions you specify

GETPIVOTDATA This function extracts data stored in a PivotTable

CHAR This function returns the character specified by the code
number

ENCODEURL This function returns a URL-encoded string

EILTERXML This funchon returns specific data from XML content by using
the specified XPath

DOLLAR This function converts a number to text, using currency
format S (Dollar)

BETADIST This func‘uon returns the cumulative beta probability density
function

ADDRESS This function creates a cell reference as text in a single cell in
the worksheet

AND This function returns TRUE if all arguments are TRUE

CELL This function returns information about the formatting,
location, or contents of the first cell

Introduction to Computer Skills




® Practical Parte (ke Chapter @
— c Microsoft Excel

BIN2DEC This function converts a binary number to decimal
DATE This function returns the number to specific date
This function returns the most frequently occurring or
MODE Y )
repetitive value in an array of data
RANK This function returns the rank of a number in a list of numbers

Common errors when using functions:

Error Error Description

Bt 'Srrflloe\l:lrr\]serted values in the cell are too long and can not be
IVALUEH# The typed formula contains error
IDIV/0# Division by zero
?’NAME# Misspelling in the function or formula name
IREF# Cell reference is incorrect
Skill 11 - 22

Knowing How to Format Cells

11 -14 Format Cells:
11 -14 -1 Changing the Format (Features) of Specific Cell:

Sometimes the user of the Excel worksheetprogram needs to change the
format (features) of a specific cell by the following:

e We click on the cell whose format we want to change.
e From the "Home" tab, we click on the "Format" option and thena menu
appears to us, so we choose "Format Cells" as in Figure1150-.
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Cell Size
I RowHeight...
AutoFit Row Height
L] Column Width...
AutoFit Column Width
Default Width...
Visibility
Hide & Unhide r
Organize Sheets
Bename Sheet
Move or Copy Sheet...
Tab Color »

Protection
[f7 Protect Sheet...
Lock Cell

|FormatC§||5... |

‘ Format Cells )

Note: There is another way to access the Format Cells option:

* We click the mouse button on the cell we want to change its format to select.
e (lick on the right mouse button and then a menu appears and from which
we choose the option “Format Cells” as in Figurel1 -51.

5 Cut
E® Copy
“D Paste Options:

=4
=

111}

Paste Special...
Inzert...
Delete...
Clear Contents
=| Quick Analysis
Filter >

Sort 3

'-'1[,3 Insert Comment

Format Cells...

Pick From Drop-down List...
Define Name...

Hyperlink...

Format Cells
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When you click on the "Format Cells" option as in the previous menu, a

dialog box will appear with a number of options that can be applied to the
cell asin Figurel1 -52.

Format Cells 7 >
[Number'! alignment  Font Border Fill Protection

Category:

Genera I Sample

Mumber Good

currency

Scctounting General format cells have no specific number format,

ate

Time

Percentage

Fraction

Scientific

Text

Special

Custom

|
Figuer11-52:
The Options
within Format
Cells

We choose the feature we want to apply to the cell and then we press OK.

Skill 11 - 23
Knowing How to Work with the Format Cells Options

i

11 -14- 2 Format Cells Options:

We find in the (format cells) option, as in Figure (8- 21), six tabs namely, number
- alignment - font - border - fill - protection and we will review a part of them:

First: Number Tab:

This tab is used in the case of cells containing numbers and you want to change
the way they are displayed and contains several options as in Figure 11- 53.
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Format Cells ? =

i Number | Alignment Fant Barder Eil Protection

ategorny:
(General | Sample

Number Good
currency
Accounting
Date

Time
Percentage
Fraction
Saentific
Text

Special Number Tab Format Options)

General format c¢lls have no specific number format.

Custom

ance

«Number Tab Format)

e The Option “Number”: This option is used in the case of the decimal point
and determining the number of decimal places you want. For example,
if you choose the (number) option and you selected the value 0 in the
decimal, places. Then, this means choosing the correct number without a
decimal point and in the case of choosing the value 1 this means the choice
of one number after the decimal point and so on, and also through which
you can select the form of a decimal point.

Format Cells ? x| Total
48

Number  Alignment Font Border Fill Protection
Category: 7
Ei“!!! Sample 7
C”'I';F_"y 46.00 7
Accolnting . =

Data Decimal places: |2 = 7
Time ] use 1000 Separator ()

Percgntage .

Fractlon [Negative numbers:

Scierfific -1234.10

Text

Specfal 123410 |

Custpm -1234.10

‘ Number ) ‘( The Number Format )

Number Is used for general display of numbers. Currency and Accounting offer specialized
formatting for monetary value.

[ ok ] caneel |

( The Number Format ’
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¢ The currency and accounting options: These two options are used in the

case of the need to specify the type of the currency (different patterns of
the currency) in a specific cell, so these optionsare used and their properties
that appear on the right of the screen can be edited as in Figure11- 55.

Format Cells ? =
‘Mumber | alignment  Font  Border Fill Protection

Category:

General Sample

Ehee oy

Accourfing Decimal pl . [z -

Date Decdmal places: | T{

Time Symbol | . . -

Percenthge S j

Fractio Negative numbers:

Scientifjc ATFEN. |,

Text

Special AT

Custom LLEE . ‘..‘J.

g Currency ' &Applying Currency Format

Currency formats are used for general monetary values. Use Accounting formats to align deamal
points in a column.

cance
( The Currency Format ’

Date and time options: They give multiple ways to show the date and time
for a specific cell after selecting it. Once you select them, you will see their
properties and then choose the property you want, as in Figurel1- 56.

Format Cells 7 ke Total

| Alignment  Font  Border Fill  Protection

Categorny:

General Sample

Number 171011317

Currency

i — |

Time S
24/07/33

Fercenmge 1433.07.24

Fractio TE/-VAEFE

scientiffe TR
IEFE LV TE
VPP sz, TE v

| 3 1 L

Arabic (Saudi Arabia) El
endar type: Date Format
'mm al-Qura Zl

[[] Input dates according to selected calendar

Date formats display date and time senial numbers as date values, Date formats that begin with
an asterisk (*] respond to changes in regional date and time settings that are specified for the
operating system. Formats without an asterisk are not affected by operating system settings.

Percentage option:On using this option the cell is multiplied by 100 and then
the result appears in the cell next to the percentage sign as in Figurel1 -57.
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Format Cells ? > Total
4800.00%

'Numher Alignment Font Border Fill Protection
Category:

General Sample .00%:
Number

Currency
Accounting
Date

4800.00%

Pecimal places: 2 i”

Special
Custom

Percentage Format)

Percentage formats multiply the cell value by 100 and displays the result with a percent symbol.

e

(Applying the Percentage Format‘

Second: The Alignment tab:

As we mentioned above, there are several tabs within the “Format Cells”
option, and we have reviewed the number tab. Continuing, we will explain the
alignment tab and its option through which you can change the direction of the
text or make an alignment of the text as you like as in Figure1158-. The following
steps explain how to apply it:

e Select the cell or cells you want to align.
* From the Format Cells dialog box, click the “Alignment” tab, as in Figure
11- 58, through which the options inside it can be applied.

e We click on the "OK" button to apply the action you took.

*The Alignment Tab )

| Alignment -

Format Cells

Number Font Border Fill Protection

Text alignment Orientation

Harizontal - .
| General T] Indent ) * .
Vertical: o [

[serom =]

Justify distributed

o =

Text control

[[] wirap text ‘ o %+ Degrees
[] shrink to it

El Merge cells
Right-to-left Text OrientatioD

Text direction:

I Context E

Alignment Properties)

| oK | Cancel

( Alignment Application ’
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Third: Font Tab:

As we mentioned above, there are several tabs within the “Format Cells”
option. We will explain the Font tab and its option, which is used to change the
font of the text and the size of the text. We can also change colors and insert
effect for them inside the cell or cells as in Figure1159-. To apply them, follow the
following steps:

e Select the cell or cells for which you want to change the font style or colors.

e From the Format Cells dialog box, click the "Font" tab, as in Figure
(11- 59), through which the font, font style, size and color can be changed
and adding some effects to it.

e We click on the "OK" button to apply the action you took.

Font Style

Format Cells

MNumber  Alignment Border Fill Protection
Font: Font style: Size:
Arial Bold 11
P Times Mew Roman (Headings ~ || | Regular 8 -~
Arial (Body] Italic 9
T _Nemad lBold | 10
T 19984 Bold Italic
T 2006 Team 12
T 4 Star Face Font b 14 v
. Undegine: Color:
Non | —— | g sas
i Font Size
Effeqs B Automatic e-
Font OptiOﬂS IThamalolors
L ISPErreree W EEEECEE —
|:| Sug?cript

e Theme Colors
1l | i

. Thisis a TrueType font. The same font will be used o l

| Standard Colors
Figuer11-59: EE EEEEE
The Font v, More Colors
Tabinthe o=
Format Cells oK Cancel
Fourth: Border Tab:

As we mentioned above, there are several tabs within the “Format Cells”
option. We will explain the “Border” tab and its option, which is used to change
the borders and color of a cell or cells. It can also be canceled and deleted as in
Figure (11 -60), and to apply the borders to the cell, we follow the following steps:

e Select the cell or cells you want to add borders to or color.
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e From the Format Cells dialog box, go to the "Border" tab as in Figure11 -60
and through it we can determine the border styles and the color of the
border, whether they are borders inside or outside the cell.

e C(lick “OK” to apply the feature.

OCEDINO G0 Gy

Fqrmat Cells ? x |Total

y 48

umber  Alignment Font Fill Protection 48
Line Presets 47
Style: 47
Nome  —r—=- : 47
r— T None  Qutline  [nside 47
___________ —|| Border 46

Text
- | ! (Border Application

Color: Text

Figuer11-60:
The Borders
Tab within

Format Cells Cancel

Fifth: Fill Tab:
As we mentioned above, there are several tabs within the “Format Cells”
option. We will explain the “Fill” tab and its option, which is used to change the

color of a cell or cells. It can also be canceled and deleted as in Figure (1161-). To
apply the fill color to the cell, we follow the following steps:

e Select the cell or cells to be filled with a color.

e From the Format Cells dialog box, go to the "Fill" tab as in Figure1161-, and
through it we can select the color that we want to add.

e C(lick “OK” to apply the feature.
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«Background Color ) ‘ Fill Tab ‘Pattern Color‘Fill Application

Fornat Cells 7 | x |Jotal
mber  Alignment Font Border w Protecti

Background Color: Pattern Color:

No Color | Automatic El
INCOEEENENN Battern Style:
OREO0O0OO00000 El
ONEREOENO0ONEE
ENEREEEONN
FEEEEENEEEN

ERf SN EEEN

Fill Effects... More Colors...

sample &Fill Effects & More Colors)

[ ox ]| cancer |

Skill 11 - 24
Knowing How to Work with the Objects

i

11 -15 Insert Objects:

Sometimes the user of excel worksheet program need to insert an object,
insert illustrations, or import an object such as a picture, clip art, or AutoShape.

Skill 11 - 25
Insert Pictures

I

11- 15 -1 Insert Picture:

e Select the cell or cells you want to insert the picture near by clicking the left
mouse button.

e From the “Insert” tab, we select “Pictures” which is located within the
“illustrations” group as in Figure (1162-).

e The Insert Picture window appears for us and we select the picture we
want to insert and click on it with the left mouse button, as in Figurel1162-.

e C(Click on the “Insert” option to apply the action.
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« Sample Pictures )

Picture Tab

\ - = w02 e " A
LQ | = ol Store [ ] ?? - ol - i [ | I@I '
Pictures Pnline Add-i . Recommended i PivotChart 3D Line Column W
Hictures @+~ Lt . Charts L ARG g v Map ~ L
llustrations Add-ins Charts s Tours Sparklines
B Insert Picture o
v P &> ASUS » e o
Insert Picture ) ool
R olblgl
> P dbgazall Wil
> [F oluiiwall
> dlaaall
b v Chrysanthemum.
[ Juaivl Olg> =]
T
B ouwsD
> B sl lals
>0 Gl il
v Wl asdll yrauad)l lis Tulipsjpg Penguins jpg Lighthousepg Kozzjpg
— n.I.V.A--. ¥
File name: v| ‘AII Pictures (*.emf*.wmf* jpg;* ~
Tools “ Insert |:|| | Cancel

Insert Picture

Another Way to Insert Pictures
To insert a picture, follow these steps:
e From the Insert tab and from illustrations group, click pictures as shown

Figuerll -63.
Home Page Layout Formulas Data Review View
[ [T —] .—& = — 1 I
EEIEE R
PrvotTable Recommended Table | Pictures Online 3 My Add-ins - Recommended
PivotTables Pictures &+ 7 Charts "
Tables llustrations Add-ins CH
11 ~ | £ || Total
4 A B c D E F
1 | Employee Name |Basic Salaryl Bonuses| Toatl (Salaryis higherthan 950
2 |Mohamed Khair 1050 200 1250 |Good
3 |Monzir Faiz 1300 400 1700 |Good
4 |Mogtaba Faiz 970 150 1120 |Good
5 |Mohamed Rabee 1200 450 1650 |Good
6 | Average 1430
7 | Max Value| 1700
8 | Total
9

e The insert picture window will appear as shown in Figure 11 -64.
e Select the picture location on the computer
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EH Insert Picture >
« v = > ASUS » 5 v B s s e o
albl v LA Ale

V1.05b_Raft_Win32 ~
R olblgl
> ol dbganall Ll=llI
> & olaiiwall
7 dlaaall
D vaswgall Jelhfishpg Hydrangexs pg ;hr.wuhmm
33 Juaidl Dlg=

> [ e

B r cas \\\\
» B seal el {

0 amll 2ilu &byt Rasly

+ sl yigusadll Lis Pmmpg
Figuer11-64: e N
Insert Picture File name: V| Al Pictores (. bt

Tools Cancel

611 Select Picture )é Insert Picture

e Choose the picture you want to insert by clicking on it with the left mouse
button once and then clicking Insert or by pressing the left mouse button
twice.

e The picture will be inserted in the document as shown in Figure 1165- Logo

picture.
A B C D E F | G H
1 | Employee Name [Basic Salary Bonuses| Toatl |Salaryis higher than %50
2 Mohamed Khair 1050 200 1250 |Good
3 Monzir Faiz 1300 400 1700 Gond
4 Mogtaba Faiz 970 150
5 Mohamed Rabee 1200 450
b Average \\
Figuer11-65: | Ve Valge
Insert Picture  § Total autiy Asols
9 UNIVERSITY or IISNI
10

Resize the Picture:

You can change the size of the pictures till they are compatible with the desired
size of the worksheet by selecting the picture by clicking on it with the mouse
button till the eight selection circles appear as in the Figure 1166-.
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( - )
.,

©
P .
Figuer11-66: = s

Image Resizing iy denls
‘ UNIVERSITY Of BISHA

* |fthe mouse pointer reaches one of the eight circles, its shape will turn into
two crossed arrows.

©

e |f you want to enlarge the picture so that you maintain the ratio between
height and width, place the mouse pointer at one of the four circles located
at the corners, then the pointer will turn into two opposite inclined arrows
at an angle of 45 degrees.

e (lick the left mouse button and then the pointer becomes crossed arrows
and drag.

e |eave the mouse button when you reach the desired size.

Insert Pictures via the Internet:

Through the excel worksheet program, we can search for pictures from various
sources and insert them via the Internet, through the following steps:

e Select the place or cell you want to insert the picture near.

e From the “Insert” tab we choose “Online Pictures” that falls within the
illustrations group as shown in Figure 11 -67.

* The Insert picture window appears for us and we write the type of picture that
we want to insert in the search box and then click Enter as in Figurell -67.
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QX Insert Online Pictures ) @ Search Area )
Lo'- | g = 'I'I-'l’l' " L Tan I
o 5 M Store j ?? 8~ i~ i‘i : l |_"'_ "p_@.l IS | T "
Recomjmended ' PiwotChart el Line Column Win/
My Add- v e
ol ;M i Clats = - ke Map ~ Loss
|l|ustrations Add-ins Charts i Tours Sparklines
X

Insert Pictures |

b

Bing Image Search

OneDrive - Personal

Search Bing I

A

Brpwse #

Figuer11-67: 2
Insert Online
Pictures

DD

For example, to search for a picture of the computer monitor, we write in the
search box as in option (4) the computer monitor and press EnterThen we wait for
the search results to appear and choose the desired picture by clicking on it with the
left mouse button and then clicking on the button “insert” as in the figure 11 -68.

1 The Search Results )

Figuer11-68:
Insert Online
Pictures

-19 Computer Monitor

Color =

Creative Commons only «

Clear filters

hese results are tagged with Creative Commons licenses: review the license to ensure you comply. Show all results

You are responsible for respecting others' rights, including
copyright. Learm more here

Select one or more items. I Insert l| Cancel ‘

e Insert
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Note: We can also change the size of the picture that was inserted into the
workbook by:

. -

Figuer11-69:

Selecting the picture you want to resize by clicking on it with the left mouse
button. Small circles will appear on the edges of the picture.

Placing the pointer on the circle in the direction you want to change the
size and then drag till we get the desired size.

We can also change the format of the pictureinserted into the workbook
by:

Selecting the picture, you want to change its format by clicking on it with
the left mouse button. The "Picture Format" tab will appear.

Many formatting options will appear in the "Picture Format" tab. Choose
the appropriate format that you want to apply, as shown in Figure 11 -69.

e Formats Tab Options) o Format Tab )

Picture
Format
Options

3 ) After Applying the Formatting)
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Skill 11 - 26
Recognizing/Knowing How to Insert Shaps

i

11-15-2 Insert Shapes:

Sometimes the user of excel worksheet program may need to insert shapes
such as circles, squares and names, or automatic graphics (SmartArt). To perform
one of the two cases, we follow the following steps:

e Fromthe “Insert” tab then “Shapes” that falls within the illustrations group,

a list will appear to us as in Figure1170-.

* We choose the shape that we want to insert by clicking on it with the left

mouse button.

* We go to the place we want to place the shape and press the left mouse

button to apply.
«Shapes Options)

L@ - | Nl Store - _
Recently Used Shapes

2 vy 4y ¥y
e

EEl O AMNOTOAAD TSSO E @
GH (OO rT Lhe” oy B8 e
0O @& s= [J @ < 5 @ <3
ci<>0C 1 € ¥
Block Arrows
= <P 4 LI G dB 7 (R I T
€ @ Wanip o 2[RRI ]
4 P
Equation Shapes
g = 53 = =
Flowchart
COCO =/ 7O LA — 1T
O O AR X © ANV OO
Q= M O
Stars and Banners

85

e i < T EOx L3 (5 (i 65 45 £
gk T sk E [T 3
Callouts
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If you need to add (SmartArt), we follow these steps:

e From the "Insert" tab then “SmartArt” which is located within the
illustrations group, we click on it with the left mouse button, and then a
menu appears as in Figurell71-.

e We go to SmartArt graphic options to choose the desired SmartArt shape

e Then we click on the desired SmartArt with the mouse

e We click on the "OK" button to apply the required SmartArt.

a SmartArt Option CZXSeIect the Sub Sha pe)
v = - - - i =
V" dlistore 1?2 -l = e P ¥ O§
e SO TR R =4
e & My Add-ins - Recommended v e PP 30 ine Humn Wir Shcer Timeline
a4+ Charts Fogod ¥ Y Map ~ 5
Choose a SmartArt Graphic ? X

[~
=g EE| e Dm —— - —
BEE| 80 S5 =
0 Process Bl o2 R -
s F Cycle T e h -
2, Hierarchy = = PR 5 F
<hi

B Relationship ) —_—
&2 Mat == QE‘ k= 2 A
| = = =
i T i R Basic Block List
|ma] Picture ALy [0 [0 (W g . d |
I - @ === = e U::rt? ,r‘wv,:wn _iau:.ﬂtml or gr:;ﬁuh.
O el W || ichemEn
Figuer11-71: '_{‘__3‘ = [E =] shapes
SmartArt i = [ F I
Graphic e 8= 1 [E =Ty
Options [Tox | cancer
SmartArt Options ° OK button

Skill 11 - 27
Knowing How to Work with Charts

i

11 -15- 3 Charts:

One of the most important features of the excel worksheet program is that we
can represent data and display it in the form of charts or graphs, through which
it can help in understanding the results more quickly, so we find that there are
several types of charts such as:

e Pivot Chart

e Column or Bar Chart

e Hierarchy Chart

e Line or Area Chart

e \Waterfall, Funnel, Stock, Surface, or Radar Chart

e Scatter or Bubble Chart

e Pie or Doughnut Chart
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To apply the chart, the following steps should be followed:

e You must specify the data (by selecting columns) from the open workbook
that you want to represent in the form of charts or graphs.
e From the “Insert” tab, we go to the “Charts” group menu, as shown in

Figure 11- 72.
% Chart Options )

— ll'l-'lli' [
U2 - - i B2

Recommended PrvotChart
Charts |~ L2~ B -
1 Charts E

& Recommended Charts ) PivotChart

e There are several types of charts with which data can be represented, such
as insert column or bar chart or insert hierarchy chart, insert waterfall or
stock chart, insert surface chart, insert scatter chart, or insert pie chart.

* |n case of the chosen the bar chart as in Figurel1 -73, then we click on the
chosen chart with the left mouse button.

g 2-D Column ) 2-D Column Menu)

e Y e R &

. =]
Wy Add-ins - Recommended Line Column Win/ Shcer Timeline  Hyperlink
Chasts

Add-ins hﬂﬂl |~| I: ‘q [ Sparklines s Fitters Links

3-0 Cobumn

D_ Elin 8l A3 SA 1B [

2-D Bar

===

3 D Bar

stare l -

30

e M=
23 = & =

20 lnd_More Column Sharts
15
10
5
0

Fahd Alla Mustafa Ahmed Alj Abdalrazg Amiro Nader

W First = Second

‘(Aﬂer Applying the Shapes)
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To Edit the Chart:

e C(lick on the chart, then click on the (Chart Design) tab to enable you to
format the layout of the chart:

e Bychoosingone of the optionsin the (chart layouts) group that allow adding
axis title, chart title, showing chart data (by clicking on the axis label), you
will be able to edit by clicking directly on the chart title or the axis title and
edit directly as in Figure 11- 74.

File Home Insert Page Layout Formulas Data Review View Design Farma

T owr ans Er

.
f
| !- 5 | og® I |
Add Chart Quick | Change l W L L || iJ ||
Element~ Layout~ Colors -

Chart Layouts Chart Styles
Charts v Je
A ., B [ D E | F | @G H
Employee Name [Basic Salary Bonuses| Toatl Salary is higher than 950
Mohamed Khair ,5 1050 200 1250 ood q
Monzir Faiz Chart Title

Mogtaba Faiz

Mohamed Rabee|| **° B

1600
1400

1200
1000
0 g
B
H
2
., HH I ] I

Mohamed Khair Manzir Faiz Mogtaba Faiz Mohamed Rabes

3
03
)

]

5|j|5|©|m|-:|m o B w N =
3

8

M Basic Salary W Bonuzes M Toad
e fa s

b [ | | | =

Skill 11 - 28
Knowing How to Change the Type and Size of Chart

L 4
To control the size of the chart:

e C(lick on the chart, so that the movement points appear on the four corners
of the chart and in the middle of each line of the chart area as shown in the
figure 11 -75.

e C(Click and hold on any of the movement points and drag in the desired
direction, so that the size of the chart directly increased or reduced.
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